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About This Document 

Purpose 
What this 
document 
provides 

The iBox/iBox Kit Installation and Maintenance Guide contains information about 
two products, the iBox and the iBox Kit. 

The document is split into three sections. Section 1: Getting Started provides an 
overview of the iBox. Section 2: iBox Installation and Maintenance provides 
instructions for installing, configuring, using, maintaining and troubleshooting the 
iBox. Section 3: iBox Kit Installation and Maintenance provides similar information 
for the iBox Kit. 

Some iBox configuration procedures provide details on the SGConfig tool.  For the 
equivalent information when using SGConfig to configure the iBox, refer to the 
SGConfig online help. 

  

SGConfig 
Online Help 

For topics related to the use of GE Digital Energy's SGConfig* configuration utility, 
or details of any software application used in a specific iBox, refer to the SGConfig 
online help. 

 

Training Tool In addition to the primary purpose of this Installation and Maintenance Guide, its 
secondary purpose is that of a Training Manual for customer training sessions 
provided by GE Digital Energy, or its agents. 

  

Operating 
System 

The procedures in this guide are based on Windows 2000. Some steps and dialog 
boxes may vary slightly if you are using Windows XP or Windows 2003. 

  

Intended Audience 
Job Titles This guide is intended for use by the SCADA system installers and field engineers 

who are responsible for the installation, hardware configuration and maintenance of 
SCADA systems containing iBox units and iBox Kits. 

  

Experience & 
Abilities 

This guide assumes that anyone working with an iBox or iBox Kit has some prior 
knowledge of: 
• Electrical utility industry 
• Personal computer terminology and interconnection skills  
• GE Digital Energy products 
• Other industry products such as protective relays, meters, and voltage regulators. 
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Additional Documentation 
 For further information about the iBox and its components, refer to the following 

documents:  

From GE Digital Energy: 
• iBox Product Overview (PRPI-043) 
• D20, D25, iBox Automation Applications (PRPI-048) 
• SGConfig online help 
• WESMAINTII+ User’s Guide (B014-1UG) 
• 68K Monitor User’s Guide (SWM0023) 
• Application software configuration guides 

From other manufacturers 
• Digi One User’s Guide (Digi International) 
• ADAM 4000 Data Acquisition Modules User’s Manual (Advantech) 
• DMMS300+, DMMS350, DMMS425 3-Phase Multifunction Power Monitors 

with Advanced Capabilities Installation, Operation and Programming Manual 
(Electro Industries/GaugeTech) 
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Product Support 

Getting Help If you need help with any aspect of your GE Grid Solutions product, you have a few 
options. 

 

Search GE 
Grid Solutions 
Web Site 

The GE Grid Solutions Web site provides fast access to technical information, such 
as manuals, release notes and knowledge base topics.  

Visit us on the Web at: http://www.gegridsolutions.com 

Search GE 
Grid Solutions 
Technical 
Support 

This site serves as a document repository for post-sales requests.  To get access to 
the Technical Support Web site, go to: 

http://sc.ge.com/*SASTechSupport 

 

Contact 
Technical 
Support 

GE Grid Solutions Technical Support is open 24 hours a day, seven days a week for 
you to talk directly to a GE representative. 

In the U.S. and Canada, call toll-free: 1 800 547 8629 

International customers, please call: +1 905 927 7070 

Or e-mail to multilin.tech@ge.com  
 

Product 
Returns 

Before you return a product, please contact GE Grid Solutions Technical Support to 
obtain a Return Merchandise Authorization number and complete instructions for 
return shipments. 

A Return Merchandise Authorization (RMA) number must accompany all equipment 
being returned for repair, servicing, or for any other reason. 
Note: Product returns will not be accepted without a Return Merchandise 

Authorization number. 

 

!
 

If you attempt to resolve problems with your GE product using methods not 
recommended by GE Digital Energy, this might result in damage or injury to persons 
and property. 
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Safety Precautions  

 

Important! Follow all safety precautions and instructions in this manual: 
• Only qualified personnel should work on the iBox/iBox Kit. Maintenance 

personnel should be familiar with the hazards associated with electrical 
equipment. 

• NEVER work alone. 
• Before performing visual inspections, tests, or maintenance on this equipment, 

isolate or disconnect all hazardous live circuits and sources of electric power. 
Assume that all circuits are live until they have been completely de-energized, 
tested, and tagged. Pay particular attention to the design of the power system. 
Consider all sources of power, including the possibility of back feed. 

• Turn off all power supplying the equipment in which the iBox/iBox Kit is to be 
installed before installing and wiring the iBox/iBox Kit. 

• Beware of potential hazards, wear personal protective equipment and carefully 
inspect the work area for tools and objects that may have been left inside the 
equipment. 

• The successful operation of this equipment depends upon proper handling, 
installation, and operation. Neglecting fundamental installation requirements 
may lead to personal injury as well as damage to electrical equipment or other 
property. 

• Many of the components within the iBox/iBox Kits are susceptible to damage 
from electrostatic discharge. Observe standard ESD (Electrostatic Discharge) 
precautions for handling electronic components at all times. 

• Read and thoroughly understand this guide before using the iBox/iBox Kit. Save 
these instructions for later use and reference. 

Failure to observe these instructions may result in death or serious injury. 
 

!
 

Hazardous 
Voltages 

Hazardous voltages can cause shock, burns or death. 
• Disconnect and lock out all power sources before servicing and removing 

components. 
• Short all current transformer primaries before servicing. 
• Do not remove the safety shields that have been installed to prevent accidental 

contact with hazardous voltages. 
• Avoid touching iBox/iBox Kit power supplies, since these supplies contain 

hazardous voltages. 
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Safety Precautions, continued 

  

Product 
Warning 
Symbols !

 

 
Caution   (refer to accompanying documentation) 

 

 

 
Caution   (risk of electric shock) 

 

 

 
Earth/Ground Terminal 

 

 

 
Protective Earth Terminal 

 

 

 
Power Supply Off (Stand-by Mode) 

 

 

 
Power Supply On 

 
 

 
Direct Current 

 

 

 
Alternating Current 

 

Damaged 
Equipment 

Do not operate an iBox or iBox Kit if it has been dropped or damaged. Return it to 
GE Digital Energy for inspection and repair. 

 

Operating 
Environment 

iBox/iBox Kits are intended for indoor use. Do not place these products in 
environments where unusual environmental conditions exist (such as dirt, liquids, or 
windblown dust) without a secondary protective enclosure. 

For proper fire protection, iBox/iBox Kits must be installed in an enclosure equipped 
with a metal floor with no openings. 

An IEC® 60947 compliant main disconnect switch (or other equivalent device 
complying with IEC 60947-1 / 60947-3) must be as electrically close as practicable 
to the iBox power supply. 
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!
 

Protection 
during 

Maintenance 

Ensure iBox/iBox Kits are protected from falling debris during maintenance. Small 
metallic particles (such as wire clippings) could fall onto circuit boards and damage 
or interfere with the safe and reliable operation of the iBox/iBox Kit. 

  

RF 
Interference 

The iBox/iBox Kit generates radio frequency (RF) energy that can radiate if it is not 
installed and used in accordance with the instructions provided in this guide. This RF 
energy may cause harmful interference to radio communications or sensitive circuits. 

Operating an inadequately shielded iBox or iBox Kit in a residential area may cause 
harmful interference, if this happens, you may be liable to correct the interference. 

 

!
 

Rack Spacing 

When mounting multiple iBox/iBox Kits in a rack (or when mounting an iBox/iBox 
Kit in a rack with other equipment), verify that there is at least one rack unit (RU) of 
space above and below the iBox/iBox Kit, to allow for cooling airflow, and for 
routing cables between field equipment and the iBox/iBox Kit (1 RU = 1.75 inches). 

 

Power and 
Fusing 

• For proper operation, input voltages must be within specified limits. Do not 
apply voltages outside this range, since this may lead to premature product 
failure. 

• Always fuse-protect field sources. 
• Always replace fuses with fuses of the same type and rating. Fuse types and 

ratings are stated in the product specifications. 
 

Grounding To ensure voltage transients are properly shunted to ground, you must connect the 
iBox’s protective earth terminal to a low-impedance ground point using a braided 
cable or heavy solid copper conductor.  

When making ground connections, ensure all grounding surfaces are free of dirt, 
residue and corrosion. You can use a coating such as Glyptal® to protect connections 
from oxidation and dirt deposits. 

Cable shields should be grounded to either the iBox/iBox Kit ground terminal or to 
field equipment, but not to both. Do not ground cable shields at more than one point, 
since potential differences between the ground points will result in ground loops and 
undesirable noise sources. 

 

Communica-
tion Cables 

• Use shielded cables to prevent electromagnetic interference. 
• Route all communication cables away from power-carrying cables, and make 

these cables as short as possible. 
• Prior to start-up, verify the integrity of all communication cables and 

connections. 
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Safety Precautions, continued 

 

Surge 
Protectors 

When connecting the iBox/iBox Kit to communications equipment (for example, 
modems or radios), use appropriate surge arrestors to protect the iBox’s 
communications ports. 

 

iBox Cover Never operate an iBox without having its protective cover installed, since product 
performance may be compromised, and equipment may be damaged if foreign 
objects fall into the unit. 

 

iBox Jumpers Configure the jumpers in your iBox before you connect field inputs and outputs. 

 

!
 

Use of the equipment in a manner not recommended or specified by GE Digital 
Energy, may impair the protection provided by the equipment. 
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CISPR 11-CE Mark Compliance 

Important For CISPR 11, Class A-CE Mark compliance on an iBox installed outside of a 
protective enclosure, you must use ferrite clamps on the following: 
• Serial communication cables attached to J2, J3, and J4  
• Wiring connected to TB2-TB15 for digital inputs and control outputs 

Note: Although the standalone iBox is CE Marked, GE does not guarantee the CE 
Mark of third-party components of the iBox Kits (such as the 10/100BaseT Ethernet 
Module or the AC and DC Analog Input Modules). 

 

Ferrite Clamp 
cabling/wiring 

The following diagram illustrates the cabling/wiring loop through an installed ferrite 
clamp. 

Connection

Ferrite Clamp

Cable/Wiring

 
 

Part Numbers Order the following part number for each of the external ferrite clamps you require. 

Part Number Color 

460-0031 White body 

460-0049 Black body 
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Section 1: Getting Started 

Overview 
Introduction Before you begin installing the iBox, review the information in this section, 

including the following topics: 
• Description of the iBox 
• Unpacking and inspection 
• Storage 
• Installation Tools 
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1.1. What is an iBox? 

Product Overview 
Introduction The iBox is GE Digital Energy small point count Substation Controller. It combines 

advanced functionality, multiple communication ports and local I/O in a compact 
package. 

The iBox processes both digital inputs and digital outputs. It also provides serial 
digital data communication ports to facilitate communications with both a master-
station and local communications. The iBox is specifically designed for SCADA 
applications.  

The iBox Kit is a rack-mounted, pre-wired, pre-configured RTU based on the iBox, 
but with additional (optional) power supply, Ethernet and I/O support. 

  

Integrated 
Functions 

The iBox can function as a: 
• Programmable logic controller (PLC) 
• IED gateway 
• Data concentrator 
• Standalone remote terminal unit (RTU). 

  

Scalable 
Architecture 

The iBox’s flexibility makes it an excellent option for: 
• Advanced substation monitoring 
• Control 
• Automation applications. 

 

Features The iBox has three software-configurable RS-232/485 serial communication ports. 
All three RS-232/485 serial ports interface to legacy IEDs or Master stations. 

An extensive library of application software is available from GE Digital Energy to 
enable the iBox to interface with a wide range of IEDs. 

A UTC port is available for global satellite time synchronization (however, there 
are three serial ports, so if you use one as a UTC port, two serial ports remain for 
connecting to IEDs). 

Maintenance port support provides access to SGConfig, LogicLinx*, and 
WESMAINT* utilities. 

Meets the robust requirements of the IEEE®, IEC® and CE Mark. 
 

Patent 
Protection  

The iBox contains a patent protection label as a formal declaration of the US patents 
that protect both the product and the technology developed by GE Digital Energy. 

 

MAY BE PROTECTED BY ONE OR 
MORE OF THE FOLLOWING US 

PATENTS: 

5237511, 5303112, 5513061, 5701226. 
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System Software 
Overview The iBox system software consists of two components: 

• Base System 

• Applications. 
  

Base System 
Software 

The Base System software provides a stable operating environment for applications, 
which provide specific functionality for the iBox. The Base System is made up of: 
• Boot software, resident in the BootROM, and  
• Base applications, required for operating the hardware. 

  

iBox 
BootROM 

BootROM software is stored in EPROM. The BootROM contains: 
• Operating system software 
• Device drivers to interface the operating system with the system hardware and 

software 
• Diagnostic software, to verify the integrity of the iBox 
• Monitor interface, for examining the system in a non-operational mode 
• Startup code, to verify and initialize the application software 
• Low-level maintenance and troubleshooting software 

  

Base 
Applications 

Standard iBox Base Applications, present in every iBox, are:  
• WIN, the system database manager 
• WESMAINT, which allows the operator to locally examine and control data 
• 68K Monitor, which provides low-level system maintenance and diagnostic tools 

 

WIN WIN (for WESDAC Interface Node) is the database manager for the iBox System 
Point Database. The System Point Database is the heart of the iBox software system. 
All data flowing through the iBox is stored in the System Point Database before it is 
passed on to its destination. 

Continued on next page 
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System Software, continued 

WESMAINT WESMAINT is the iBox’s primary maintenance and diagnostic tool. You can access 
WESMAINT in three ways: 

• Through the iBox WESMAINT port 

• Through a modem or other serial connection to a programmed COM port 

• Over a LAN or serial PPP connection, as a telnet session from a remote network 
station 

WESMAINT is accessed using a VT100 terminal, or a PC running terminal 
emulation software. 

 

Database 
Display 

Through WESMAINT, you can access the following: 
• Digital inputs and outputs 
• Counters (or accumulators) 
• Device status 
• Sequence-of-events (SOE) and change-of-state (COS) data 
• System status information 
• Error log information 
• User login buffer 
• Other application-specific information 

  

Other 
WESMAINT 
Functions 

In addition to displaying information, a WESMAINT user can also: 
• Set or clear accumulator counts 
• Operate digital outputs 
• Clear logged information 
• Access the iBox 68K Monitor. 
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System Software, continued 

68K Monitor The iBox 68K Monitor, available through WESMAINT, is a diagnostic tool used to 
access system-level functions. 

The iBox 68K Monitor is resident in both BootROM and flash memory. 

When the Monitor is operated from BootROM, the following prompt appears: 
D25S>. This mode is accessed only while the iBox is in a maintenance state, since 
forcing an iBox into this mode terminates all running applications. 

When the Monitor is operated from flash, the following prompt appears:  D25A>. 
This is the normal mode of operation, and it can be accessed via WESMAINT at any 
time without disrupting unit operation. 

  

Note Using the 68K Monitor requires detailed knowledge of the iBox architecture and 
functionality. Refer to the 68K Monitor User’s Guide (SWM0023) for complete 
instructions about command usage and availability. 
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Application Software 
Background A wide range of applications can be added to the iBox to enhance its functionality. 

Software applications fall into three categories: 
• Data Collection Applications (DCA) 
• Data Processing Applications (DPA) 
• Data Translation Applications (DTA) 

  

Data 
Collection 
Applications 

Data Collection Applications are used to import (collect) data from external sources, 
and to pass this data to WIN (the system point database manager) for storage in the 
system database. DCAs also forward output requests from the system database to 
external sources. 

 

Data 
Processing 
Applications 

Data Processing Applications are configured to select and format data from the 
system database, and forward this data to a SCADA host or master station 

 

Data 
Translation 
Applications 

A combination of a DPA and a DCA, Data Translation Applications use data from 
the system database to perform logical operations, the results of which create new 
data. This new data is then placed back in the system database, where it can be used 
as input/output data by another application. 

 

Firmware The set of applications installed on an iBox is referred to as its “firmware”. 

Firmware is installed in the iBox flash memory prior to shipment. The iBox 
operational characteristics can, however, be upgraded at a later date. 

Contact your GE Digital Energy representative for more information on firmware 
upgrades. 
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Plant I/O Subsystem 
Plant I/O 
Subsystem: 
Overview 

The iBox Plant I/O Subsystem collects, processes, and stores data related to physical 
inputs and outputs. Once it is stored in the system database, I/O point data can be 
accessed by other applications. 

  

Plant I/O 
Subsystem: 
Functions 

The Plant I/O Subsystem is responsible for scanning of iBox physical I/O points. For 
input type points (digital and accumulator), the data of each scan is compared to 
previous known data. Changes are recorded in the system database, then reported to 
other applications, as needed. 

The Plant I/O Subsystem: 
• Scans and processes up to 8 digital inputs 

• Controls up to two digital outputs and two master trip/close relays. 

Requests for digital outputs are accepted and processed as soon as they arrive. 
  

Fixed Number 
of Points 

The Plant I/O DCA maintains a fixed number of points in the System Point 
Database. The actual number of points is determined by the version of the P097 Plant 
I/O Subsystem that has been installed on your iBox. 

The hardware options available in the iBox (and the user’s software configuration) 
determine if specific system features and data points are available or disabled. 
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1.2. Unpacking and Inspection 
 

Shipping 
Inspection  

Inspect the shipping package before opening it to see if it has sustained any damage 
from impact or water. If it has, report it immediately to the carrier without opening 
it. Carriers may not assume responsibility for damage after the customer accepts 
delivery. 

  

Unpacking  Carefully remove the iBox from its shipping package. Visually inspect the unit to 
ensure it has not sustained any visible damage during transit. 

The figure below shows an iBox removed from the shipping package. 

 
 

Package 
Contents 

The following items are provided as part of your iBox shipment: 
• iBox or iBox Kit unit 
• WESMAINT serial cable 
• IBOX/iBox Kit Installation and Maintenance Guide (994-0047) 
• CD including the software and copy of user documentation 

  

Product 
Identification 

Before installing the unit, check that the unit part number is the same as the part 
number on the shipping and ordering documents. 

 

Part Number Label 
Location 
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Unpacking and Inspection, Continued 

 

Part Numbers This table contains part numbers and descriptions for each iBox variant: 

Part Number iBox Description 

505-0100 24 V Digital Input and 4 Trip/Close Control Outputs 

505-0101 48 V Digital Input and 4 Trip/Close Control Outputs 

505-0102 110/125 V Digital Input and 4 Trip/Close Control Outputs 

505-0103 24 V Digital Input and 2 Trip/Close and 2 Form A Control Outputs 

505-0104 48 V Digital Input and 2 Trip/Close and 2 Form A Control Outputs 

505-0105 110/125 V Digital Input and 2 Trip/Close and 2 Form A Control 
Outputs 

Note: Part Numbers are subject to change without notice. 
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1.3. Storage 
Environment Specifications for storage are: 

• Temperature:  -40° to +90°C 

• Relative humidity:  0 to 95%, non-condensing 

As a general rule, always store your iBox in an environment compatible with 
operating conditions. Refer to Appendix A: Technical Specifications for more 
detailed environmental specifications 

Exposure to excessive temperature or other extreme environmental conditions might 
cause damage and/or unreliable operation. 

  

Battery Life The iBox battery maintains the unit’s NVRAM contents for over five years, with 
system power applied.  

If you are storing your iBox for extended periods, you should disconnect the battery 
by removing the iBox’s top cover and pulling the battery out of the chassis. 

If you are storing a new iBox which has the battery “PULL” tab in place, you do not 
need to remove the battery for storage; the “PULL” tab disconnects (insulates) the 
battery function. 

  

Recycling of 
Batteries 

 

The iBox Lithium battery is recyclable and does not contain mercury, cadmium, or 
lead in levels above those regulated by the European Union. Recycle the battery 
according to local waste management regulations. 

In accordance with European Directive 2006/66/EC, batteries are marked with the 
crossed out wheeled bin, which indicates that they cannot be disposed of as unsorted 
municipal waste in the European Union. Users of batteries must use the collection 
points available to customers for the return, recycling, and treatment of batteries. 
Customer participation is important to minimize the negative effects of batteries to 
the environment and sustain available natural resources. For more information see 
www.weeerohsinfo.com. 
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1.4. Installation Tools 
  

Tools for the 
Job 

Before beginning the installation procedure, ensure you have the following tools and 
equipment: 
• A Windows PC with HyperTerminal (or any Windows based terminal 

emulation software) loaded 
• Ethernet Cable[s] 
• A flat screwdriver with 0.6 x 3.5 mm blade (for terminal block wiring) 
• A #2 Phillip-Server Screwdriver (for rack mounting the unit) 
• A #1 Phillip-Server Screwdriver (for removing and installing the communication 

boards) 
• Needle Nose Pliers 
• Wire Cutters 
• Wire Strippers 
• Wire Crimping Tool (Panduit® CT-1525 or equivalent). 
• 6 fork connectors 
• Fork type Panduit part number PV14-6F for 14-16 AWG wire or PV18-6F for 

18-22 AWG wire (or equivalent) 
   

ESD 
Protective 
Gear 

It is recommended that the following ESD gear be used during installation:  
• Wrist Straps 
• Foot Straps 
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Section 2: iBox Installation and Maintenance 

Overview 
Introduction This section covers the following topics: 

• Familiarization of the iBox 
• Installing the iBox 
• Configuring the iBox 
• Testing the iBox 
• Connecting and testing field wiring 
• Servicing the iBox 
• Maintaining the iBox software 
• Troubleshooting the iBox 
• Replacing the iBox 

  

 



GE Grid Solutions iBox/iBox Kit 
Installation and Maintenance Guide 

 

 

GE Information 994-0047-5.10-4 25 

 

2.1. Familiarization 
Front Panel As you look at the iBox, the: 

• Left side has four DB9 connectors (serial ports), a three-position separable 
terminal block (power connection), and a protective earth terminal. 

• Right side has a 28-position terminal block for field I/O, separable in pairs. 

 

 

 
 

Operation and 
Maintenance  

You can operate and maintain the iBox configuration through the WESMAINT port. 

 

Inputs/ 
Outputs 

The iBox provides the following: 

• Eight digital inputs 
• Four control outputs 

 

Digital Inputs The iBox provides the following digital inputs: 
• Eight optically isolated status inputs, 25 VDC or 125 VDC, with 20% overload 
• Wetting options 
• LED indications 
• 4-5 mA typical current burden per input (up to 48 VDC) 
• Maximum 0.5 W heat dissipation per input from current burden of inputs at 

125 VDC 
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Continued on next page 
Familiarization, continued 

Control 
Outputs 

The iBox provides the following control outputs: 

• Four Trip/Close pairs, or two Trip/Close pairs and two Form A contacts. 
• Separate Master Trip and Master Close relays 
• Security features:  

− Protection against erroneous operation due to single point of failure 
− Select-before-operate (SBO) functionality 

• 35 W breaking @ 125 VDC, 180 W breaking @ 30 VDC 
• 6 A current handling capability 
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2.2.  Installing the iBox 

Overview 
 

Safety 
Precautions 

Before beginning to install the iBox, thoroughly review the “Safety Precautions” for 
guidelines and warnings regarding the safe handling and installation of the product. 

 

Installation 
Steps 

Installing the iBox involves the following main steps: 

 

Step Action 

1  Physically install the iBox. 

2  Connect power source and serial interfaces. 

3  Power up the iBox and check for normal operation.  

4  Configure the iBox using SGConfig. 

5  Test the iBox. 

6  Connect and test field wiring. 
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Installation Guidelines 
Installation 
Environment 

The iBox must be installed in an environment that provides protection against shock 
and fire hazard.  

The iBox enclosure is intended for indoor use, primarily to provide protection 
against accidental contact with the enclosed modules and voltages. Do not place the 
product in environments where unusual conditions exist (windblown dust and dirt, 
for example) unless you install it in a secondary protective enclosure. 

Never operate an iBox in the field with the top cover removed. Operation with the 
top cover removed may alter product performance specifications, and result in 
component damage from foreign matter entry. 

Do not install and/or operate the iBox upside down. 

Ensure all nuts and screws are tightened securely.  

Ensure that iBox is protected from falling debris during installation. 
 

Power Supply 
Source 

An IEC® 60947 compliant main disconnect switch (or other equivalent device 
complying with IEC 60947-1 / 60947-3) must be as electrically close as practicable 
to the iBox power supply. 

For correct iBox power supply operation, the input voltage must be within specified 
limits. 

The iBox DC power supply draws an inrush current (less than 0.5 A) upon start-up. 
Ensure the field source can supply this start-up current without overloading. 

Continued on next page 
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Installation Guidelines, continued 

Power Fusing Always replace fuses with the same type and rating used by GE Digital Energy. The 
fuse types and ratings are stated in “Fuse Replacement” on page 59.  

Always fuse-protect field power sources. 
  

Grounding 
and Shielding 

To ensure safe operations, you must connect the iBox Protective Earth Terminal to a 
low impedance ground using braided cable or heavy solid copper conductor. When 
making ground connections, ensure all grounding surfaces are free of dirt, residue 
and corrosion. 

Ensure cable shields are grounded at either the iBox functional ground terminal or at 
the field equipment. Do not ground the shields at more than one point because a 
potential difference may exist between grounds, resulting in ground loops and 
undesirable noise sources. 

To prevent electromagnetic interference from upsetting iBox operation, use cables 
with an over-all cable shield. Route all communication cables away from power-
carrying cables. 

  

Communi-
cations Ports 
and 
Connections 

Verify the integrity of all communication cable connections prior to start-up to avoid 
damaging the iBox.  

Serial ports are protected with surge and noise suppression components. 

Always shield communication cables and make them as short as possible. 
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Physical Mounting 
Procedure:  
Mounting the 
iBox 

Step Action 

1 Align the iBox in its proper position on a flat mounting surface. 

2 Install and tighten the four screws, holding the iBox firmly in place on 
the mounting surface. 

3 Loosen the iBox top cover and remove the battery “PULL” tab.  The 
iBox is delivered with this tab in place to insulate the battery during 
shipment. 

 

 

Mounting and 
Clearance 

Leave at least one rack unit (RU) of space above and below the equipment to allow 
for cooling air flow and cable routing (1 RU = 1.75 inches or 44.5 mm). 
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Terminal Connections 
Power Supply The iBox’s power supply connection is a three-position terminal block located on the 

bottom left side of the iBox. This removable terminal block must be disconnected to 
turn off the power supply input. The iBox does not have an ON/OFF switch. 

 
 

Functional 
Ground/ 
Chassis 

Connect the ground screw terminal to the facility’s ground system before operating 
the iBox. Before making this connection, ensure all grounding surfaces are free of 
dirt, residue and corrosion. The maximum wire gauge for terminal blocks is 12 
AWG. 

 

Internal 
Overcurrent 
Protection 

An internal MDL 0.5 A (slow blow) fuse protects the iBox power supply. 

 

Power 
Connection 
Procedure 

To connect the power source: 

Step Action 

1 Connect ground wire to the ground terminal. A 12 AWG green and 
yellow wire is recommended. 

2 Connect the DC power supply, observing the correct polarity, to the 
positive and negative connection points on TB1 

 

  

!
 

The chassis ground terminal at the power supply terminal block must not be used as 
a protective earth connection. 

 

!
 

Make sure the iBox is properly grounded to the protective earth terminal located at 
the bottom-left corner of the board. Connection must be provided with a separate 
green/yellow wire connected between the iBox and the facility’s ground system. 

 

  

+   

–   

Chassis   TB1   
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System Diagnostics 

System 
Diagnostics 

Once power is applied, the iBox automatically boots and conducts a series of self-
diagnostic tests. If the iBox fails to boot up properly (which indicates that a self-
diagnostic failure has occurred), it might have sustained internal damage during 
shipping. Contact GE Digital Energy for assistance. 

  

LEDs The POWER and RUN LEDs will both light during the self-diagnostic sequence. 
  

Diagnostics 
Completed 

Self-diagnostics have completed successfully when the POWER and RUN LEDs are 
on solid. 
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Connecting Serial Interfaces 
WESMAINT 
Port 

The iBox is equipped with a WESMAINT port. By attaching a WESMAINT cable 
between the WESMAINT port and your PC, the iBox can: 
• Provide local maintenance and diagnostic functionality 
• Download configuration data from the optional SGConfig software 

With the cable connected, you can also upload diagnostic and operational 
information to the PC. 

The WESMAINT interface supports RS-232 signaling and normally operates at a 
fixed rate of 9600 bps. 

   

WESMAINT 
Cable 

To connect to a PC, use a WESMAINT cable (GE part number 977-0048/96), or 
equivalent. 

The schematic for this cable is shown below: 
  

    

Terminal - DB-9 Female WESMAINT - DB-9 Male

COM
N/C
TXD
RXD
N/C
N/C
N/C
N/C
N/C

N/C
RXD
TXD
N/C

COM
N/C
N/C
N/C

GND

1
2
3
4
5
6
7
8
9

1
2
3
4
5
6
7
8
9  

 

Standard 
Serial 
Interfaces 

The iBox has three serial communications ports:  COM1, COM2, and COM3 

All COM ports have the following standard characteristics: 
• Female DB-9-F style connectors 
• RS-232 and RS-485 are supported on the same physical connector. 

Continued on next page 
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Connecting Serial Interfaces, continued 

COM1 
Options 

In addition to the standard characteristics, COM1 has the following optional 
characteristics: 
• Jumper-selectable (JP3) radio key, open-collector output 
• Communication parameters, determined by the protocol application. 

   

COM2 
Options 

COM2 can optionally be used to connect to a satellite time-code receiver, as follows: 

Time code J3 Pin Interface Signal 

IRIG-B 8 RS-232 CTS2 

Rugby Clock 2 RS-232 RX2 

 5 RS-232 COM 
 

 

IRIG-B Output 
Options 

IRIG-B receivers are available with modulated and/or unmodulated output options. If 
the unmodulated output of the receiver is a coaxial connection, a converter will be 
required to interface to the iBox. 

 

COM Ports COM ports provide the following: 
• Variable communication parameters 
• Optional software flow control 
• Optional hardware flow control 
• Out-of-sequence transmission of one byte of data 
• Support for several I/O timers 
• Transmission of break characters 

 

COM Port 
Options 

The COM1, COM2 and COM3 serial ports are programmed using SGConfig  for: 
• RS-232 or RS-485  
• RS-485 2-wire or 4-wire (2W/4W)  

Note: The 2W/4W selection in SGConfig only affects the interface’s internal 
software control (handshaking). It does not change the physical 
characteristics of the communication ports. 
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Connecting Serial Interfaces, continued 

Serial Port 
Pinouts 

The COM port pin-outs, for both RS-232 and RS-485 configurations, are as follows: 

DB-9 Pin RS-232 RS-485 

1 CD N/C 

2 RX RX- 

3 TX TX- 

4 N/C N/C 

5 Com GND Com GND 

6 N/C* N/C 

7 RTS TX+ 

8 CTS RX+ 

9 EARTH GND EARTH GND 

*   Radio Key Open Collector Output for COM Port 1 only (jumper selected with JP3 
installed). 

 

 

2-Wire RS-485 
Cable 

The following schematic shows the cable wiring necessary for 2-wire RS-485 
operation. 

 
Description         PIN #

1
2
3
4
5
6
7
8
9

N/C
Data -
Data -

N/C
Common Ground

N/C
Data +
Data +

Earth Ground

- TX / RX

+ TX / RX

 

 

iBox Connectors J2, J3 or J4 
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2.3. Configuring your iBox 

Overview 
Introduction You can create a project for configuring your iBox device using SGConfig. 

 

Configuration 
Template 

A sample configuration is included on the CD with the iBox. You can create the 
iBox device configuration starting from the sample configuration or create a new 
configuration from scratch. 

After you successfully create a device configuration, you can use it as a template for 
all subsequent iBox configurations. To do so, copy the original configuration file, 
and edit the copied file as necessary.  

After creating the device, the remaining procedures are the same, whether you are 
working with a copy of an existing configuration or creating a new device 
configuration. 

 

Configuration 
Steps 

The iBox is configured using the SGConfig configuration system.  

Configuring the iBox involves the following main steps: 

• Create or restore a SGConfig project. 

• Create and configure the iBox device in the project. 

• Configure the application firmware. 

• Configure the Plant I/O. 

• Download the configuration to the iBox. 

For the detailed procedures, refer to the SGConfig online help. 
 

Before you 
Start 

To configure the iBox, you will need the following items: 

• Factory configuration for your iBox. You can find this on the configuration CD 
that shipped with your iBox. 

• SGConfig installed on your PC. 

• Serial number of your iBox, from the iBox circuit board 
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Restoring your SGConfig Project 
 

Introduction This procedure describes how to restore the SGConfig project that includes the 
sample configuration provided with the iBox. 

 

Procedure:  
Restoring 
your 
SGConfig 
Project 

Step Action 

1  In your Windows desktop, click Start, and then click Programs. 

2  Click SGConfig, > SGConfig. 

Result: SGConfig opens. 

Importing the Factory Configuration 

3  Click GE > Archive > Project > Restore. 

4  Click Restore. 

Result: The Restore Project Details window appears: 

 

5  Insert your configuration CD in the drive. 

6  Navigate to the configuration file in the Archive File Name field. 

7  Click OK.  

Result: The configuration file uploads to your PC, and your project 
appears in an SGConfig project tab. 
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Creating a New iBox Device 
Introduction Creating an iBox device in SGConfig has two main steps: 

• Create the new device 
• Specify the device properties 

This procedure assumes that you are using the default firmware already loaded in the 
iBox or have created a firmware set. 

   

iBox Device 
Icon 

When you create a new iBox device, select the iBox device template to see the 
appropriate configuration screens. 

   

Procedure:  
Creating a 
New iBox 
Device 

To create a new iBox device: 

Step Action 

1  Open the project in which you want to create the iBox device. 

2  Drag and drop an iBOX device template from Local Repository > 
Device Templates into the project tab area.  

3  Click Edit group > Properties command. 

Result: The iBOX Device Wizard appears. 

 

4  In the Name box, type a unique name for the device.  

5  Continue to “Procedure:  Setting iBox Device Properties”. 
 

Continued on next page 
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Procedure:  Creating a New iBox Device, continued 
 

iBox Device 
Properties 

Once you have created the iBox device, follow the procedures below for setting the 
iBox device properties. 

  

Procedure:  
Setting iBox 
Device 
Properties 

To set the iBox device properties: 

Step Action 

Hardware Tab 

1  In the iBox Device Wizard window, click the Hardware tab. 

2  Click the Memory Model tab. You should not need to change the Base 
System and Global Variable Area settings. If necessary, change the 
NVRAM Area value to suit your specific system. 

3  On the Serial I/O tab, configure each com port for RS-232 or RS-485 
communications. 

Note: The 2W/4W selection in SGConfig only affects the interface’s 
internal software control (handshaking). It does not change the 
physical characteristics of the communication ports. 

Processor Tab 

4  Click the Processor tab.  

5  On the Firmware tab, click the Select button to display the available 
firmware definitions.  

6  In the Use Firmware Type field, select the firmware definition that 
matches your iBox’s applications. 
Result: The Name field shows the name of your firmware selection. 

7  From the Memory Model tab, check that Derive From iBox 
Hardware Setting is selected. 

8  Click Close to complete the creation of the new iBox device. 

The wizard closes. 
 

New Device  
Icon 

 

After you complete these steps, an iBox icon, representing your new device, appears in the main proje  
window. The new iBox device is now ready to be configured. 
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Configuring Application Firmware 
 

Overview The iBox uses the D25 Plant I/O Subsystem (P097) Data Collection Application to 
configure the digital inputs. Configure the iBox Plant I/O before you configure the 
points in the System Point Database application.  

 

Procedure: 
Digital Input 
Configuration 
 

To configure the DC digital inputs: 

Step Action 

1  Configuring the iBox PPP Driver and Internet Data 

2  Double-click the D25 Plant I/O Subsystem icon. 

Result: The D25 Plant I/O for iBox dialog box appears. 

3  
Double-click the DC Configuration  icon. 

Result: The D25 DC Configuration for iBox dialog box appears. 

4  On the General tab, select the type of digital input board from the First 
Digital Input board list. Select one of: 

• C:  iBox 8 channels, 24 V wetting 
• D:  iBox 8 channels, 48 V wetting 
• E:  iBox 8 channels, 125 V wetting 

The other board settings are preset. 

Result: The letter in the Device Code changes to match your selection. 

Note: Refer to the on-line help in SGConfig for details on configuring 
the I/O Configuration and Advanced tabs. 

 

 

Other 
Application 
Configuration 

Configure your other applications before continuing to install the iBox. Each 
application has its own configuration process. Refer to the documentation for your 
specific applications for configuration information. 
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Downloading your iBox Configuration 
Procedure:  
Downloading 
your iBox 
Configuration 

Step Action 

1  If you have not already done so, connect your PC to the iBox 
WESMAINT port and open SGConfig. 

2  In the SGConfig Project window, click the iBox device icon. 

3  Click Communications group > Connect > TeraTerm command. 
Result: The TeraTerm window appears within an SGConfig tab. 

4  Press ENTER. 
Result: SGConfig prompts you to enter a user name. 

5  Type westronic and press ENTER. 
Result: SGConfig prompts you to enter a password. 

6  Type your password (the default is rd) and press ENTER. 
Result: The following screen appears: 

 

7  Enter “2”. 
Result: The following screen appears: 

 

8  Enter “3”. 
Result: The 68K Monitor command prompt appears. 

9  In the command line, type el /r then press ENTER. 
Result: The iBox clears its error log. 

Tip:  To speed up the configuration download, temporarily change the 
baud rate of the WESMAINT serial port from the default 9600 baud to 
38400 baud in WESMAINT and SGConfig.  
To change the baud rate: 
• In WESMAINT, enter baud 38400 at the 68K command line. 
• In the SGConfig Terminal Emulator window, on the 

Communications menu, click Options. On the Port Settings tab, set 
the Baud Rate to 38400 and click OK. 

 

Continued on next page 
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Downloading your iBox Configuration, continued 

Procedure:  
Downloading 
your iBox 
Configuration 
(continued) 

Step Action 

10  On the SGConfig click Terminal Emulator Connectivity group, click 
Connect. 
Result: SGConfig connects to the iBox and the 68K Monitor command 

line appears. 

11  On the SGConfig click Terminal Emulator Actions menu, click Sync To 
Device. 
Result: The configuration download starts. 

A confirmation window appears when the download is 
complete. 

12  Click Reboot. 
Result: The iBox reboots. 
Note: If you changed the baud rate to 38400, the WESMAINT 

communications rate automatically restores to 9600 baud after the 
iBox reboots. You need to manually restore the SGConfig 
terminal emulator communications rate to 9600. 

13  From SGConfig, click the Connectivity group > Disconnect command. 
Note: If you changed the baud rate to 38400, the WESMAINT 

communications rate automatically restores to 9600 baud after the 
iBox reboots. You need to manually restore the SGConfig 
terminal emulator communications rate to 9600.  

14  On the File menu, click Exit. 

15  Physically disconnect your PC from the iBox. 
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Configuring the iBox to work with a DNP3 I/O Module 
Introduction Your iBox RTU Master communicates with your DNP3 I/O modules through 

the DNP3 Data Collection Application (DCA B023). The DNP DCA collects 
data from, and sends control requests to, the DNP3 I/O modules.  

Refer to Appendix F: Installing and Connecting DNP3 I/O Modules for 
installation and connection instructions.  

Use SGConfig to configure the DNP3 DCA in the iBox so that it 
communicates with your DNP3 I/O module. There are three tables to 
configure: 
•       Remote Device Table:  This table contains one record for each DNP 

I/O module in the system. The Remote Device Table specifies the 
remote devices with which the DCA communicates, the polling 
parameters for each remote device, and the points configured on each 
remote device. Each record in the Remote Device Table references the 
appropriate Remote Device Point Mapping Table(s) and Remote 
Device Polling Table(s). 

•       Remote Device Point Mapping Table:  Specifies the number and type 
of data points associated with each DNP I/O module. 

•       Remote Device Polling Table:  Specifies the polling type and frequency 
for each DNP I/O module. 

Instructions and guidelines for configuring your DNP3 DCA can be found in 
the following documentation: 
•     DNP V3.00 DCA - Configuration Guide (B023-0CG) 
•     SGConfig online help. 

Note:  When configuring the Time Sync option: 
•    Disable Time Sync for the D20A and  D20K modules 
•    If Time Sync is enabled on a D20S module, the polling rate may be a 

minimum of 2 seconds (it takes about 850ms to do a Time Sync for each 
device).  
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Configuring the iBox to work with a DNP3 I/O Module, continued 

Example 
Configuration 

For example, when configuring your iBox RTU Master to work with a DNP 
Digital Input Module, assume that you have a DNP Digital Input Module: 

•   That is factory-configured with 64 digital inputs 

•   That has DNP address 0032 

•   Which is to be polled every 500 ms. 

•   With every poll, we want a full status update. 

To meet these requirements, you would configure the DNP DCA as shown in 
the below table: 

Table Parameter Value 

Remote Device Table Application Address 0032 

Remote Device Point 
Mapping Table 

DCA Object Type Binary Input 

Number of Device Points 64 

Remote Device Polling Table Poll Data Type Integrity 

Poll Interval 500 ms 
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2.4. Testing your iBox 

Overview 
Introduction This section describes a number of system checks that you can perform to verify 

your iBox software is functioning properly. 
   

Valid 
Configuration 
File Required 

Before performing any of the tests in this section, you must have a valid 
configuration file loaded into the iBox’s NVRAM. The iBox is typically shipped 
with a valid configuration file loaded during manufacturing, and this file should be 
still loaded when the unit is delivered to your site. 

In the event that you do not have a valid configuration file loaded into your iBox’s 
NVRAM, or the file becomes corrupted before the unit is installed, you must reload 
the file before performing these verification tests. 

For help restoring your configuration file, refer to the online help in SGConfig. 
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LED Descriptions 
Overview You can verify the iBox is operating properly by inspecting the LEDs on the iBox 

chassis. 
 

Description The iBox has the following LED indicators, all of which are GREEN. 

 
LED Location Description 

PWR Top left The POWER LED remains lit when the iBox is receiving 
power. 

RUN Top left The RUN LED flashes to indicate CPU bus activity. Brightness 
indicates more CPU bus activity. 

TX1 – TX3 Left side The TRANSMIT LED flashes when the iBox is transmitting to 
an outside device. There are three transmit LEDs, one for 
each communication port. 

RX1 – RX3 Left side The RECEIVE LED flashes when the iBox is receiving a signal 
from an outside device. There are three receive LEDs, one 
for each communication port. 

RS1 – RS3 Left side The Request to Send (RTS) LED only works on systems 
configured for RS-232 communications. There are three RTS 
LEDs, one for each communication port. 

CS1 – CS3 Left side The Clear to Send (CTS) LED only works on systems 
configured for RS-232 communications. There are three CTS 
LEDs, one for each communication port. 

CD1 – CD3 Left side The Data Carrier Detect (DCD) LED only works on systems 
configured for RS-232 communications. There are three 
DCD LEDs, one for each communication port. 

I/P1 – I/P8 Right side Each of the iBox’s eight Digital Inputs (DI) has a LED that 
remains lit when the DI is receiving a wetting voltage. 
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Diagnostic Tools 
General To operate the iBox, you require the following system components: 

• WESMAINT facility 
• iBox monitor facility 
• SGConfig configuration system. 

 

WESMAINT Each iBox has a WESMAINT facility that allows users to examine the iBox 
database, applications and communications, and to manipulate the data. 

You can, for example, use WESMAINT to examine the state of digital input data, or 
to force a digital output ON or OFF. 

WESMAINT uses a series of menus and screens that display on a VT100 terminal, 
or similar terminal emulator, to create a simple interface to the iBox. 

With a VT100-compatible terminal emulation program or SGConfig, you can access 
the WESMAINT facility directly. 
Note: For further information about using WESMAINT software, refer to the 

WESMAINTII+ User’s Guide (Document Number B014-1UG). 
 

68K Monitor The iBox’s 68K Monitor is a debugging and diagnostics tool that is accessible in two 
ways: 
• As a menu selection available through WESMAINT 

• Upon start-up of an iBox that has not been previously configured. 
Note: For further information about using the iBox Monitor, refer to the 68K 

Monitor User’s Guide (Document Number SWM0023). 

 

SGConfig Use SGConfig to define the iBox’s operating parameters. You can also use 
SGConfig to download configuration files to the iBox through a serial connection. 
Note: For further information about SGConfig, refer to the SGConfig online help. 
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Boot Test Verification 
System 
Diagnostics 
(POST) 

The iBox software includes a Power On Self-Test (POST) process, which runs when 
the unit is powered ON and determines whether or not the iBox circuitry is working 
properly. 

  

Terminal 
Emulation 
Software 

Terminal emulation software is not part of the iBox system, but you can use terminal 
emulation software such as HyperTerminal® or SGConfig terminal utility for these 
tests. 

  

WESMAINT 
Terminal for 
Set-up 

Use the following procedure to set up a PC as a WESMAINT terminal: 

Step Action 

1  Open HyperTerminal (provided with Windows® operating system), or 
other VT100-compatible terminal emulation software. 

2  Verify (or set) the terminal communications settings as follows: 

Data Rate 9600 bps 

Data Bits 8 

Stop Bits 1 

Parity None 

Flow Control XON/XOFF 

Connector Settings COM1, COM2, as required 
for your computer 

  
 

Continued on next page 
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Boot Test Verification, continued 

Connect to 
the 
WESMAINT 
port 

 
 

Step Action 

1 Connect a WESMAINT cable to the female DB-9 WESMAINT port on 
the top left side of your iBox. 

2 Attach the other end of the WESMAINT cable to the PC’s selected 
communications port. 

3 Verify the power cable is properly connected to iBox, and power is 
available. 

4 The POWER and RUN indicators on the front upper left-hand corner 
illuminate when power to the iBox is turned ON. 

5 Monitor the VT100 terminal’s display 

Result: A series of text scripts displays as the POST routines are 
performed. If you do not see the text scripts, check all 
connections and repeat the procedure. 

  

iBox Boot Up The iBox automatically boots as soon as the power is turned on. 

If the iBox fails to boot up, it may have sustained damage during shipping. Contact 
GE Digital Energy for assistance. 
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Log in to WESMAINT 
General When the POST is complete, you can log in to WESMAINT to continue further 

testing. 
  

Procedure: 
Logging into 
Wesmaint 

To log into WESMAINT from a PC: 

Step Action 

1 Press ENTER 

Result: The Welcome screen appears, as does a login prompt. 

Note: If the Welcome banner does not appear, and only a <iBoxS 
prompt displays, a valid code or configuration file is not loaded 
into the iBox’s memory. Stop this procedure and refer to 
“Downloading Code Files” on page 65 for procedures for 
restoring files 

2 Type the User Name: westronic and press ENTER. 

3 Type the Password: rd and press ENTER. 

Result: The WESMAINT Main Menu appears 

4 If a time-out occurs, press ENTER again, to return to the login prompt 
 

  

User Name 
and Password 

The user name and password shown above are factory defaults. If you cannot log in, 
contact your system administrator to obtain the correct user name and password. 

  

Navigating in 
WESMAINT 

Use the UP and DOWN arrow keys, or type in the menu number, to select an option 
from the Main Menu. Press CTRL+L at any time to log out of WESMAINT 

  

Further 
WESMAINT 
Information 

For further information about using WESMAINT, refer to WESMAINTII+ User’s 
Guide (Document Number B014-1UG). 
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2.5. Connecting and Testing Field Wiring 

Overview 
Introduction This section describes the process for making and testing field connections to the 

iBox. 
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Digital Inputs 
Digital Inputs The iBox has eight digital inputs (DIs). 

  

Wetting Types All DIs require an input voltage signal large enough to turn on an optical switch. If 
the DI is receiving a sufficient wetting voltage, the green LED associated with the DI 
will light. 

 

Digital Input 
Thresholds 

The following table shows the iBox’s ON and OFF state thresholds. Verify that 
inputs do not exceed the maximum overload voltage; otherwise, the iBox may be 
damaged. 

 

Digital Input 
Options On Threshold Off Threshold Max Overload Voltage 

Low Voltage Digital Input 

24 VDC >14 VDC <5 VDC 24 VDC + 20% 

48 VDC >28 VDC <10 VDC 48 VDC + 20% 

High Voltage Digital Input 

110/125 VDC >80 VDC <20 VDC 125 VDC + 20% 
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Digital Input Configuration 
Digital Input 
Field 
Connections 

Field wiring for all digital input variants are made through the iBox’s terminal 
blocks, separable in pairs. 

  

Digital Input 
Wetting 
Selection 

The digital input is wetted (or turned ON) by closing a contact across the two input 
termination points. The voltage that is switched at the input terminals is supplied by 
an external source. The external power source is connected to terminal block TB-10, 
positions 1 and 2, as shown below. 

  

!
 

All eight digital inputs are bipolar. Use care when connecting multiple external 
power sources, since the digital inputs have common returns. 

  

Wiring 
Diagram:    
Dry Contact 
Operation 

This diagram illustrates the DC input connections, from Input #1 (TB2) through 
Input #8 (TB9). TB10 accepts DC voltages of either polarity. The input voltage level 
to TB10 is determined by the purchased option. 

2 1 1 22 1

Input #1 Input #8 External Wetting
Power Supply

TB2 TB9 TB10

+/- V
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Digital Outputs 
Operating 
Modes 

iBox control outputs have two modes of operation: 
• Trip/Close (T/C) pairs 
• Digital Output (DO) isolation Form A contacts. 

Note: Using SGConfig, you must configure the digital outputs for four Trip/Close 
outputs or two Trip/Close and two digital outputs, depending on the part number. 

 

Wiring Four 
Trip/Close 
Outputs  

(Part No.  
505-0100,  
505-0101,  
505-0102) 

You can wire four trip/close outputs, as follows: 

 

  

Wiring Two 
Trip/Close 
and Two 
Digital 
Outputs 

(Part No.  
505-0103,  
505-0104,  
505-0105) 

You can wire two trip/close and two digital outputs, as follows: 

 

   

Important iBox digital outputs are not internally fuse-protected. 
   

Remote/Local 
Operation 

If: Then operation is: 

JP2 is installed Remote (controls are enabled) 

JP2 is removed Local (controls are disabled) 
 

  

TB15 TB14 TB13 TB12 TB11 

Trip 4 
Close 4 

Trip 3 
Close 3 

Trip 2 
Close 2 

Trip 1 
Close 1 

1 2 1 2 1 2 1 2 1 2 

Master T/C 
(+/- V) 

GND 

TB15 TB14 TB13 TB12 TB11 

Trip 2 
Close 2 

Trip 1 
Close 1 

1 2 1 2 1 2 1 2 1 2 

Master T/C 
(+/- V) 

GND 
Digital Out 2 

(Form A) 
Digital Out 1 

(Form A) 
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Digital Input Verification Test 
Testing 
Digital Inputs 

To view digital input changes through WESMAINT, log in to WESMAINT as 
outlined in “Boot Test Verification” on page 48. 

  

Note The quantity and relative position of data points in the iBox’s System Point Database 
is determined by the version of the iBox Plant I/O software application present in 
your iBox’s firmware. 

You can determine the actual point number that you want to test by viewing the point 
descriptions in WESMAINT, or through the SGConfig configuration tables for your 
iBox. 

 The point descriptions viewed in WESMAINT will be modified by changes you 
have made to the point descriptions in the iBox configuration file 

  

Procedure: 
Testing 
Digital Inputs 

The following procedure, accessible through the WESMAINT Main Menu, assumes 
digital inputs for the iBox are wired and wetted. 

Step Action 

1 Select 1 — Digital Input Display. 
Result: The point numbers and (optionally) point descriptions appear 

on the WESMAINT display 

2 Use arrow keys to move up or down to highlight the desired point 
number (or press CTRL+G if you already know the point number) 

3 Short out the desired input point, and verify, through WESMAINT, that 
the point status has changed to ON. 

4 Return to Step 2 to test other digital input points 
 

  

Navigating 
through 
WESMAINT 

• Press N to move to the Next page 
• Press P to move to the Previous page 
• Press ESC to move back to the previous menu level. 
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Digital Output Verification Test 
Testing 
Digital 
Outputs 

To force digital outputs through WESMAINT, first log in to WESMAINT as 
described in “Boot Test Verification” on page 48. 

  

Note 
 

The quantity and relative position of data points in the iBox’s System Point Database 
is determined by the version of the iBox Plant I/O software application present in the 
iBox’s firmware. 

You can determine the actual point number that you want to test by viewing the point 
descriptions in WESMAINT or in the SGConfig configuration tables for your iBox. 
The actual point descriptions in WESMAINT will be modified by any changes you 
have made to the point descriptions in the configuration file. 

  

!
 

Use caution when testing digital output points that are connected to external 
equipment. This test may activate or damage external devices, such as relays or 
reclosers, and could injure personnel. 

  

Procedure: 
Testing 
Digital 
Outputs 

From the WESMAINT Main Menu: 

Step Action 

1 Select 1 — System Data Display 

2 Select Digital Output Display 

Result: The point numbers and (optionally) point descriptions appear 
on the WESMAINT display. 

3 Use arrow keys to highlight the desired point number (or press CTRL+G 
if you already know the point number). 

Result: The cursor flashes on the specified point number 

4 Press CTRL+F when you are ready to force-change the state of the digital 
output point. 

Extra Security 

5 At the Password prompt, type control and press ENTER 

Result: The Digital Output Force Display appears. 

6 Press CTRL+U to change (update) the relay state. 
 

Continued on next page 
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Digital Output Verification Test, continued 

Procedure: Testing Digital Outputs, continued 
 

Step Action 

7 Press the SPACE BAR to select Pulse, and press ENTER. 

8 In the Off time field, type 500 and press ENTER. 

9 In the On time field, type 500 and press ENTER. 

10 In the Repeat Command field, type 10 and press ENTER twice. 

Result: Listen carefully for an audible click of the point relay. A test is 
considered successful if the relays click when forced. 

11 For testing Trip/Close type operation, repeat steps 1- 6. 

12 Press the SPACE BAR to select Trip/Close, and press ENTER. 

13 In the Off time field, type 300 and press ENTER. 

14 In the On time field, type 300 and press ENTER. 

15 In the Repeat Command field, type the value 0 and press ENTER twice. 
Result: Listen carefully for an audible click of the point relay. A test is 

considered successful if the relays click when forced. 
Note: For Trip/Close operation in Repeat Command field, if field 

input value is other than zero it results in a WIN write request 
failed error message with status 0x0011 (operation not supported 
for this point).Refer to Appendix G: Error Messages.   

  

Notes Note: The password shown above is factory default. If you cannot log in, contact 
your system administrator to obtain the new password.  

Note: The number of times that a control will operate is actually N+1, where N is 
the number of repeats entered in the Repeat command field. For a single 
operation, with no repeats, type 0. For two operations, type 1. 

 

Test Failure If relays do not operate: 
1. Ensure that the CONTROLS enable jumper is in the REMOTE position. No 

error message appears in WESMAINT if the test fails 
2. Reboot the iBox, and repeat the procedure 
3. Call GE Digital Energy for assistance 

  

Repeat Test To repeat the test sequence, press CTRL+U, and then press ENTER. 
Values entered for the previous test are retained until you exit the menu. 

  

Test Next 
Point 

To test another point, use the UP or DOWN arrows to cycle through points, then press 
CTRL+U to repeat the test. 
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2.6. Servicing your iBox 
Introduction This section provides information and procedures for maintaining the iBox.  

The iBox does not require any scheduled maintenance, other than periodic inspection 
to ensure that the: 
• Unit has sustained no accidental physical damage, 
• Airflow is not obstructed, and 
• Connectors and cables are intact and firmly attached. 
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Fuse Replacement 
Fuse Location Under normal operation, the iBox should not require disassembly. The only time you 

should have to open the iBox is to replace the fuse. 
  

Fuse Location The fuse is located in position F1 on the main board. To find the fuse, remove the 
iBox top cover, and look to the bottom left corner of the main board, close to the 
protective earth terminal. 

  

Procedure To replace the fuse: 

Step Action 

1  Remove power to the iBox. 

2  Remove the top cover. 

3  Remove the fuse. 

4  Replace the fuse with a GE fuse, part number 940-0215. The fuse type is 
MDL 0.5 A 250 V. 

5  Replace the cover. 

6  Reconnect the power. 
  



iBox/iBox Kit  
Installation and Maintenance Guide GE Grid Solutions 
 

60 994-0047-5.10-4 GE Information 

 

Battery Replacement 
Battery 
Location 

The battery is located in position BT1 on the main board. To find the battery, remove 
the iBox top cover, and look to the bottom center-right of the main board, close to 
the column of relays. 

  

Battery Type The iBox uses a 3 V, BR2/3A, lithium battery, GE part number 980-0026. 

  

Procedure To replace the battery: 

Step Action 

1  Remove power to the iBox. 

2  Remove the top cover. 

3  Remove the battery by removing the holder clip. 

4  Replace the battery with a GE battery, part number 980-0026. Check that 
battery has been inserted correctly by verifying the polarity markings. 

5  Snap the battery holder clip back into place. 

6  Replace the cover. 

7  Reconnect the power. 
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2.7. Maintaining your iBox Software 

Overview 
Introduction The iBox is factory pre-configured and tested. It contains all required operating 

software, and is able to upload and download configuration files. 
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About Code and Configuration Files 
Background iBox operation requires two different files: 

• Code File:  This file defines the applications that can be supported by the iBox. 

• Configuration File:  This file, which is generated using SGConfig, is used to 
enable and configure the applications’ operating characteristics. 

  

Important The Code File and the Configuration File must be consistent. 

Specifically, the configuration file created using SGConfig must be based on the 
same applications (and versions of these applications) from which the code file was 
created. 

Any differences between the applications in the code and the configuration files may 
result in: 
• Erratic or unpredictable behavior of the iBox 
• Failure of the iBox software 

  

Configuration 
and Code File 
Mismatch 

Code and configuration file mismatch can occur for one of the following reasons. 

• The wrong configuration file is downloaded to the unit. This can happen through 
a local SGConfig download; for example, the downloaded file could have been 
based on an iBox with a different code file. 

• The code file that is downloaded does not match the configuration file that is 
resident in the iBox memory. 

• The code file or the configuration file has become corrupted, either before or 
during download. 

  

Preventing 
File Mismatch 

Configuration and code file mismatch can be prevented and corrected, as follows. 

• Since mismatch is usually a result of operator error, you can prevent it by 
exercising care. 

• Erasing a configuration file that is resident in NVRAM before downloading a 
new code file can prevent mismatch. 

• Mismatch may require the regeneration and re-downloading of one or both files. 

Continued on next page 
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About Code and Configuration Files, continued 

System 
Response to 
File Mismatch 

The iBox base system performs the following procedure after each reboot: 

1. Every time the iBox reboots, a counter increments 

2. If the iBox runs for two minutes without a reboot, the counter clears. 

3. If the counter reaches 20, the base system invalidates the configuration and 
forces a system reset. 

4. When the iBox comes back up, the base system will sense the now-invalid 
configuration and will either create a default configuration or load a backed-up 
configuration, if one is available. 

This process protects the system from file problems that might cause the system to 
reset before the user can access WESMAINT to rectify the problem. 

While a user can always directly default the configuration by pressing <ESC> during 
the start-up sequence, this only works if the customer is physically present and 
connected to the WESMAINT port. 
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Deleting Configuration Files 
Erasing a 
Configuration 

Erase a configuration file from the iBox’s NVRAM before downloading a new code 
file into FLASH memory, unless the code file is exactly the same as the one that was 
in use before the download. 

There are two ways to erase a configuration file from the iBox memory: 
  

Restoring the 
Default 
Configuration 

Step Action 

1  Reboot the iBox. While it is starting, press the ESCAPE key. 

Result: The following message appears: 
 Are you sure you wish to generate a  
 default configuration [y\n]? 

2  Type Y and press ENTER 

Result: The configuration restores to default. 
 

 

Erasing the 
Configuration 
File 

Step Action 

1  With a terminal connected to the iBox 68K Monitor, type DHW (Display 
HardWare) or SI (System Information) on older units.  

Result: A listing of information, including the start address and size of 
the NVRAM used for the configuration file, displays. The 
NVRAM end address can be calculated by adding the NVRAM 
size to the NVRAM start address. 

2  Type F 00 <NVRAM Start Address> <NVRAM End Address> and press 
ENTER. 

Result: The specified range of NVRAM fills with 0s, erasing any 
configuration files. 
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Downloading Code Files 
When to 
Download 

There are two reasons for downloading code files: 
• If the iBox has performed self-diagnostics and determined that the flash memory 

is either erased or corrupt, it will display the D25S> prompt on the system 
monitor when it requires code files to be downloaded 

• If the iBox software program features need to be changed or upgraded, the 
existing flash memory can be erased, and new code downloaded. 

  

Programming 
Flash Memory 

There are three ways to program iBox flash memory (the one you use will depend on 
your system options and network type): 

• Connect a PC, running terminal emulation software, to the WESMAINT port. 
This procedure is described below. 

• Use SGConfig to access the iBox through the WESMAINT port. 

• Using a parallel port adapter and software utility, connect directly to the iBox 
BDM (Background Debug Mode) port. This procedure, which facilitates very 
fast downloads, is used during the manufacture of the iBox. 

  

Before 
Downloading 

When a new code image is downloaded into the iBox flash memory, the amount of 
memory reserved for the configuration’s data region, also referred to as the  “Base” 
region, may not be large enough. 

If this occurs, the following message (or a similar message) displays: 
The configuration’s data region overlaps the current 
Configuration Header (NVHEADER).  Relocate the 
Configuration Header / NVRAM to <address>, or set data size 
to <size> and re-download.  Application will NOT be 
started. 

If this message appears, refer to the SGConfig online help on how to set the iBox 
Device Properties to increase the Base System area. 

  

Note Using the Windows HyperTerminal for a code download procedure can take up to 
two hours to complete. 

Continued on next page 



iBox/iBox Kit  
Installation and Maintenance Guide GE Grid Solutions 
 

66 994-0047-5.10-4 GE Information 

 

Downloading Code Files, continued 

Serial Code 
Download: 
Requirements 

You will need the following before you can download a code file into the iBox flash 
memory: 
• Windows PC with HyperTerminal (or equivalent) communication software. 
• Code file, in Motorola S-record format, on the PC’s hard drive. If the file is 

located on a network or floppy drive, the download will be significantly slower. 
This file will typically be named either  down.shx, or salxxxx.shx. 

• WESMAINT cable, for connecting the PC to the iBox WESMAINT port. 
  

Before 
Starting the 
Download 

The serial code download procedure will suspend all iBox operations. Following the 
download, the unit will likely require a configuration download before it becomes 
operational. Consult your system administrator for access and authorization to 
perform system download procedures 

In the Application Monitor (the D25A> prompt displays), configuration files can be 
downloaded but code files cannot. To download code, the System Monitor (the 
D25S> prompt displays) must be running. 

  

Procedure: 
Serial Code 
Download 

Use the following procedure to download a code file to the iBox flash memory: 

Step Action 

Access Application Monitor 

1  Connect WESMAINT serial cable from PC to the iBox’s WESMAINT 
port 

2  Start your terminal emulation software, and configure it as follows: 

Data Rate 9600 bps 

Data Bits 8 

Stop Bits 1 

Parity None 

Flow Control XON/XOFF 

Connector Settings COM1, COM2, as required 
for your computer 

  
 

Continued on next page 
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Downloading Code Files, continued 

Download Procedure, continued 

Note If the iBox does not have a code file loaded, or if it has detected a corrupt flash file, 
you will have to go directly to Step 8 and log directly into the monitor. 

Step Action 

Launch System Monitor 

3  Log into WESMAINT. 

4  Select option 2, System Functions. 

5  Select option 3, 68K Monitor. 

Result: The D25A> prompt appears, indicating that the Application 
Monitor is running. 

6  At the D25A> prompt type rtb ENTER. 

For other available commands type help ENTER. 

7  At the Return to the BootROM Operating System? (yes/no) prompt, 
type yes and press ENTER 

Note: The monitor is not case-sensitive, but Y is not acceptable 

Result: The system restarts.  

!
 

 
While the iBox is rebooting, the system is disabled. 

 

Log in to the System Monitor 

8  After the restart is complete, press ENTER. 

Result: The Login: prompt appears. 

9  Type the login name westronic ENTER and password rd ENTER. 

Result: The system performs self-diagnostics to ascertain whether any 
Flash EPROM memory is in use. The D25S> prompt appears, 
indicating the System Monitor is running. 

Clear Flash EPROM 

10  Type erase and press ENTER (not case-sensitive). 

Result: The recommended procedure is to clear flash EPROM 
memory, no matter what the system check reveals. 

Continued on next page 
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Downloading Code Files, continued 

Download Procedure, continued 
 

Step Action 

11  Type Y  ENTER at the Do you wish to proceed? prompt (not case-
sensitive). 

Result: The system automatically verifies that Flash EPROM memory 
has been cleared. The D25S> prompt appears. You can start 
the download. 

Optional steps to speed up the download time: 

12  Type Baud 38400 ENTER (speeds up to 38.4 kbps, may be chosen based 
on ambient EMI, cable length, PC and software limits etc.). 

Result: The monitor now communicates at 38.4 kbps. 

13  Configure HyperTerminal to communicate at the same speed, and 
reconnect to the 68K monitor. 

Optional step to provide feedback during the download: 

14  If the communication software you are using does not have any 
“progress indicator’, such as HyperTerminal, you can enable echo to 
visually display the code file on your monitor as it is transferred. 

This option can usually be found in the communication settings or 
properties of the communication program. 

Note: Enabling echo can slow transfer slightly 

Start Download 

15  Type dl and press ENTER. 

16  Select Send Text File (or comparable command) from program menus. 

Note: You can only download Motorola S-Records. 

17  Locate and select a file to download. 

18  Press ENTER to invoke the download procedure. 

Note: Download can take from 20 to more than 45 minutes, depending 
on file size and speed of transfer. 

Result: The download completes, and the D25S> prompt appears. 
 

Download Fails If the transfer does not complete or it stalls, halt and restart the transfer. 

  

Download is 
Successful 

Reboot the iBox, watching the display on the PC monitor. Note that the iBox 
monitor speed returns to 9600 bps, if it was changed during the procedure. 

If any error codes display, you may have to repeat the procedure. 
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2.8. Troubleshooting your iBox 

Overview 
Introduction This section provides instructions on what to do if the system malfunctions, or when 

error messages appear in WESMAINT. 
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Runtime and Startup Errors 
Overview This section provides instructions on what to do if the system malfunctions, or when 

error messages appear in WESMAINT. 

Note: Plant I/O errors are reported as changes in the state of specific digital input 
points. These events are logged to the WESMAINT SOE Buffer Display. 

   

If WESMAINT 
Will Not Run 

In severe cases, the WESMAINT application may not run at all. If this happens: 

Step Action 

1  Access the System Monitor. 

2  Type EL /P. 

3  Type EL/R. 

4  Reboot the iBox. 

5  Press ENTER 

Result: A low-level error log displays. 

If these tables fail to help remedy the situation, or if you need help 
interpreting error messages, contact GE Digital Energy for assistance. 

 

 

Continued on next page 



GE Grid Solutions iBox/iBox Kit 
Installation and Maintenance Guide 

 

 

GE Information 994-0047-5.10-4 71 

 

Runtime and Startup Errors, continued 

iBox Trouble-
shooting Tips 

Symptom Possible Causes Suggestions 

Active Operations 
Aborted 

Controls Jumper is in the Local 
position (JP2 is removed). 

Move the Controls Jumper 
to the Remote position 
(Install JP2). 

Active Requests 
Aborted 

The iBox Plant I/O Subsystem 
monitoring detects a conflict 
between desired and actual 
coil status (a coil is not 
energized when it should be). 

Verify coil status. 

Digital Output 
Requests Rejected 

Controls Jumper is in the Local 
position (JP2 is removed). 

The iBox Plant I/O Subsystem 
monitoring detects a conflict 
between desired and actual 
coil status (a coil is not 
energized when it should be). 

Move the Controls Jumper 
to the Remote position 
(Install JP2). 

Verify coil status. 
 

Queued Requests 
Cleared 

Controls Jumper is in the Local 
position. 

The iBox Plant I/O Subsystem 
monitoring detects a conflict 
between desired and actual 
coil status (a coil is not 
energized when it should be). 

Move the Controls Jumper 
to the Remote position 

Verify coil status 

System Hangs Watchdog failure. Attempt Reboot, clear CCU 
error logs 

Plant I/O Watchdog 
Failure 

Plant I/O Subsystem integrity is 
faulty. 

Remove and restore power 
to the iBox 

Digital output Points 
are Disabled 

The Local/Remote Jumper is in 
the Local position (JP2 is 
removed). 

Move the Local/Remote 
Jumper to the Remote 
position (Install JP2). 

Communication 
Watch Dog Failure 

Internal system monitors 
detect serious errors. 

Attempt Reboot, clear CCU 
error logs. 

Coil Status Check The iBox Plant I/O Subsystem 
monitoring detects a conflict 
between desired and actual 
coil status. 

Verify coil status. 

Digital output coils are 
not in the state 
requested by the 
software 

Plant I/O Sub failure 

Hardware Watchdog. Check Control Voltage 
source fuses. Check voltage. 
Force from WESMAINT 

Digital Output Failure Control Voltage Not Available, 
Coil Status Check, or Hardware 
Watchdog error condition. 

Check Control Voltage 
source fuses. Check voltage. 
Force from WESMAINT. 

 

Continued on next page 
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Runtime and Startup Errors, Continued 

Symptom Possible Causes Suggestions 

NVRAM Check Failure System start-up fails Use WESMAINT to view the error 
message, and refer to related 
configuration guide for 
suggestions. 

Application Checksum 
Failure 

System start-up fails Use WESMAINT to view the error 
message, and refer to related 
configuration guide for 
suggestions. 

BootROM Checksum 
Failure 

System start-up fails Use WESMAINT to view the error 
message, and refer to related 
configuration guide for 
suggestions. 

Start-Up Failure RAM check, NVRAM check, 
Application checksum, or 
BootROM checksum failed 
during system start-up. 

Use WESMAINT to view the error 
message, and refer to related 
configuration guide for 
suggestions. 

System Shut Down RAM, NVRAM, FLASH, or 
BootROM internal system 
diagnostics failed. 

Use WESMAINT to view the error 
message, and refer to related 
configuration guide for 
suggestions 

Only the System 
Monitor is Running 

No valid application code 
is detected. 

Load application code 

Code Download 
Failure 

Download interrupted or 
data error encountered in 
downloaded file. 

Clear Flash EPROM memory. 
Restart download procedure. 

Cannot Download 
Code 

Logged into the 
Application Monitor. 

Exit Application Monitor, and 
launch System Monitor. 
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Initialization Errors 
Overview Several error situations, related to initialization, can occur with file transfers. The 

most common case will be that the configuration and code in the Boot File are those 
in the memory of the client causing the client to initialize immediately. Other 
possibilities exist. 

 
Symptom Possible Causes Suggestions 

BootROM Error  Press escape to reset 

TFTP Error Configuration was not completed 
or data corruption has occurred at 
the server 

Use WESMAINT to view 
the error message 

Applications Not 
Enabled 

Configuration was not completed 
or data corruption has occurred at 
the server 

Use WESMAINT to view 
the error message 

System Restarts Data download failure Use WESMAINT to view 
the error message 

Only diagnostic input 
can be entered 

No configuration is detected in 
either NVRAM or in EPROM on 
start-up 

Download a 
configuration remotely 
via the system monitor, 
and reboot 

System error  No configuration is detected in 
either NVRAM or in EPROM on 
start-up 

Download a 
configuration remotely 
via the system monitor, 
and reboot 
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Errors Indicated by LEDs 
Overview The following errors are indicated by the LEDs: 

 
Symptom Possible Causes Suggestions 

PWR LED does not 
light 

Unit is not receiving power Confirm that power 
source is working 

RUN LED does not light Unit is not receiving power 
 

No BootROM 

Confirm that power 
source is working 

Confirm BootROM 
installed at U4XU4 

TX LED does not light Unit is not transmitting any data 

RTS, CRS, DCD settings are 
incorrect 

Check cabling to 
modems.  

If connected to a modem 
or converter, ensure RTS, 
CTS, DCD are enabled 

If using a Direct Serial 
Connection, try disabling 
RTS, CTS, DCD 

RX LED does not light Not receiving any data Same as above 

RS LED does not light RTS line disabled Enable RTS 

CS LED does not light Modem not working correctly Check modem cabling 

CD LED does not light Not receiving data Check modem cabling 

Ensure modem is 
receiving data 

I/Px (DI LEDs) do not 
light 

The input device is not operating 
properly 

Confirm that the input 
source is working 
properly 
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2.9. Replacing your iBox 
Introduction This section outlines procedures for replacing an iBox. 

  

Equipment 
Needed 

• Standard electrician’s tools (screwdrivers and flashlight) 
• Replacement iBox. 

  

Before 
Installing 

Verify that the replacement iBox unit is fitted with the same options and connectors 
as the original unit, before proceeding. 

Refer to “Product Identification” on page 20 for detailed information. 
 

!
 

Since hazardous voltages can cause shock, burns or death: 
• Disconnect and lockout all power sources before servicing and removing 

components 
• Short all current transformer primaries before servicing. 
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Replacing your iBox, continued 

Procedure: 
Replacing an 
iBox 

Use the following procedure to replace an iBox: 

Step Action 

Removing the Existing iBox 

1 Power down the iBox by unplugging power from TB1. 

2 Disconnect ground from the iBox. 

3 Ensure no voltage or current is applied to any of the terminals on the 
iBox. Use a meter if necessary. 

4 Remove field wiring connections 
Important: When the new unit is installed it is important that these 

wires are reconnected to the same points from which they 
were removed. Record the position of each wire as it is 
removed. 

5 Remove communications cables from the iBox 
Important: Note the location and orientation of each cable as it is 

removed 

6 Remove the disconnected iBox from its mounting position 

Installing the Replacement iBox 

7 Mount the new iBox. 

8 Reconnect the field wiring to the same points as they were on the 
original unit. 

9 Reconnect any communications cables that were removed to the same 
points as they were on the original unit. 

10 Restore ground and power to the iBox. 
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Section 3: iBox Kit Installation and Maintenance 

3.1. Familiarization 
Overview In addition to the iBox features, the 19” rack-mountable iBox Kit can be optioned to 

provide DC analog inputs AC analog inputs, an Ethernet connection, and support for 
a wide range of power supply input voltages. Examples of DC and AC iBox Kits are 
shown below. 

 

 

 

 

Power Supply 

19” Mounting 
Plate 

COM Ports 
iBox 
Digital Inputs 
and Outputs 

Ethernet 
Module 

AC Analog 
Input Module 

AC Kit 

DC Kit 

COM Ports 

Digital Inputs 
and Outputs 

iBox 

DC Analog 
Input Module 

Protective 
Earth Terminal 

AC Input 
Terminations 

Power Supply 

Protective Earth 
Terminal 
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What is an iBox Kit?, continued 

Components  The iBox Kit consists of the following components: 

• iBox. See “What is an iBox?” on page 14 for more information. 

• 24 VDC Power Supply (20 - 60 VDC or 88 - 300 VDC/88 - 264 VAC input) 

• 10/100BaseT Ethernet Module (optional) 

• DC Analog Input Module (optional, eight DC analog inputs) 

• AC Analog Input Module (optional, 3 CT and 3 PT inputs) 

An example configuration of the iBox AC Kit is illustrated below (other options of 
the iBox Kit are equipped differently): 

 

AC Kit  

Power 
Supply 

AC Analog Input 
Module 

iBOX 

Ethernet Module 

RS-485/PPP 

10/100BaseT Ethernet 

20 - 60 VDC 
88 - 264 VAC 
88 - 300 VDC 24 VDC Output 

RS-485/Modbus 

RS-232/485 
Serial Port 

RS-232 
Maintenance Port 

4 Digital Outputs 
8 Digital Inputs 

3 CT Inputs 
3 PT Inputs 

 

 

 

DC Kit An example configuration of the iBox DC Kit is illustrated below (other options of 
the iBox Kit are equipped differently): 

 

Power 
Supply 

DC Analog Input 
Module 

iBOX 

Ethernet Module 

RS-485/PPP 

10/100BaseT Ethernet 

20 - 60 VDC 
88 - 264 VAC 
88 - 300 VDC 24 VDC Output 

RS-485/Modbus 

RS-232/485 
Serial Port 

RS-232 
Maintenance Port 

4 Digital Outputs 
8 Digital Inputs 

8 DC Analog Inputs 
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What is an iBox Kit?, continued 

Operation and 
Maintenance  

The iBox Kit can be configured to operate over a LAN or through a serial 
connection. 

If you configure the iBox Kit to operate over a LAN, you can maintain the iBox 
configuration over the LAN or directly through the WESMAINT port. If you operate 
the iBox Kit through a serial connection, you can only maintain the iBox 
configuration through the WESMAINT port. 

 

Inputs/ 
Outputs 

The iBox Kit provides the following: 

• Eight digital inputs 
• Four control outputs 
• Eight DC analog inputs (optional) 
• Three PT (120/208 V) and three CT (5 A) AC analog inputs (optional) 

 

Digital Inputs The iBox Kit provides the following digital inputs, directly from the iBox: 
• Eight optically isolated status inputs, 25 VDC or 125 VDC, with 10% overload 
• Wetting options 
• LED indications 
• 4-5 mA typical current burden per input (up to 48 VDC) 
• Maximum 0.5 W heat dissipation per input from current burden of inputs at 

125 VDC 
 

Control 
Outputs 

The iBox Kit provides the following control outputs, directly from the iBox: 

• Four Trip/Close pairs, or two Trip/Close pairs and two Form A contacts. 
• Separate Master Trip and Master Close relays 
• Security features:  

− Protection against erroneous operation due to single point of failure 
− Select-before-operate (SBO) functionality 

• 35 W breaking @ 125 VDC, 180 W breaking @ 30 VDC 
• 6 A current handling capability 

 

DC Analog 
Inputs 
(option) 

The iBox Kit provides the following DC Analog Inputs through a DC Analog Input 
Module: 

• Eight DC analog inputs 
• DC voltage options:  +1 VDC, +5 VDC, +10 VDC 
• DC current options:  +20 mA, 4–20 mA 
• 14-bit resolution plus sign 

Continued on next page 
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AC Analog 
Inputs 
(option) 

The iBox Kit provides the following AC Analog Inputs through an AC Analog Input 
Module: 

• Single circuit monitoring (wye connected) 

• VRMS, IRMS, Phase Angle, Frequency, Power Factor 

• Real Power (W), Reactive Power (VAR), Apparent Power (VA) 

• Watt-Hour 

• Nominal PT input range: 0 to 150 VLN or 250 VLL 

• Nominal CT input: 5 A 

• Frequency: 50/60 Hz 

• Measurement range: 0 to 125% of nominal 

• Accuracy: 0.3% 

• Continuous overload withstand: 200% of nominal 

• Short duration overload withstand: 100 A for 3 s 

• Surge withstand as per IEEE C37.90.1, ANSI C62.41 

• True RMS sampling at 64 samples per cycle 

• Isolation: 2500 VAC/60 Hz 

• Burden: 
− Voltage & Current: 0.1 VA max 

− Power Supply: 6 VA max 

 

Power Supply The power supply provides 24 VDC power to all iBox Kit components. It can also 
deliver limited 24 VDC power to customer-provided equipment. The power supply 
comes in two input voltage-range options: 
• 20 - 60 VDC (7 A max) 
• 88 - 300 VDC (1.4 A max) / 88 - 264 VAC (2.1 A max) 

Maximum output is 24 VDC / 4 A or 24 VDC @ Vin min. For further clarification 
regarding the power supply, consult the manufacturer’s power supply guide as listed 
in the Additional Documentation section. 

 

Remote 
Maintenance 

If your iBox Kit is equipped with an Ethernet interface, you can access and configure 
the iBox from a remote PC running SGConfig.  
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What is an iBox Kit?, continued 

PPP (Point-to-
Point 
Protocol) 

The iBox uses PPP to communicate through the iBox Kit Ethernet Module to a LAN, 
or externally to communications equipment such as a radio. 

 

IP Addressing When it is equipped with an Ethernet Module, the iBox Kit requires three IP 
addresses, two external and one internal, as shown below: 

iBOX Kit

Ethernet
Module

LAN

iBOX
IP
#1

IP
#2

IP
#3

PPP

 

IP #1 and IP #3 are both accessible from the LAN. IP #2 is internal to the iBox Kit 
and is not accessible from the LAN. You set IP #2 and IP #3 when you configure the 
Ethernet Module. The Ethernet Module calculates IP #1 (equal to IP #2 + 1), and 
assigns this address to the iBox through PPP. 

 

Configuration The iBox Kit ships pre-configured, based on your order; however, you need to 
configure the PPP Driver, Ethernet Module IP addresses, and SCADA protocol (e.g., 
DNP or IEC) addresses. You configure the iBox Kit components as follows: 

Component Configuration Method 

iBox Locally through the iBox maintenance (WESMAINT) port, from a PC 
running SGConfig. If it is equipped with an Ethernet Module, the iBox 
can also be configured through the LAN, from a remote PC running 
SGConfig. Refer to “Configuring the iBox Kit Components” on page 
87. 

Ethernet 
Module 

Locally through the module’s Ethernet port/Web server, from a 
computer running a Web browser. Refer to “Configuring the 
Ethernet Module” on page 109. 

DC Analog 
Input Module 

Locally through the device’s RS-485 port, from a computer running 
the vendor’s configuration utility. Refer to “Configuring the DC 
Analog Module” on page 123. 

AC Analog Input 
Module 

No configuration typically required. 

 

 

Default 
Configuration 
Options 

When shipped as part of an iBox Kit, the iBox comes preconfigured for that 
particular option, as shown in Appendix B: iBox Kit Default Configurations. 
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3.2. Installing the iBox Kit 

Overview 
 

Safety 
Precautions 

Before beginning to install the iBox Kit, thoroughly review the “Safety Precautions” 
for guidelines and warnings regarding the safe handling and installation of the 
product. 

 

Installation 
Steps 

Installing the iBox Kit involves the following main steps: 

 

Step Action 

1  Physically install the iBox Kit. 

2  Connect power source, ground and serial interfaces. 

3  Power up the iBox Kit and check for normal operation.  

4  Configure the iBox Kit components. 

5  Test the iBox Kit. 

6  Connect and test field wiring. 
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Physical Mounting 
Rack Spacing When mounting the iBox Kit in a rack with other equipment, leave at least one rack 

unit (RU) of space above and below the equipment to allow for cooling air flow and 
cable routing (1 RU = 1.75 inches or 44.5 mm).  

 

Required 
Clearances 

The exterior dimensions of the iBox Kit are: 
• 8.75” high x 19" wide x 2" deep (22.2 cm high x 48.3 cm wide x 5.1 cm deep) 

 

Procedure – 
Mounting the 
iBox Kit 

To mount the iBox Kit on a rack: 

Step Action 

1 Determine the location of the iBox Kit in the 19-inch mounting rack. 

2 Insert, but don’t tighten the top two mounting screws. 

3 Slide the iBox Kit over the top mounting screws and drop down into position. 

4 Insert the bottom mounting screws. 

5 Tighten all four mounting screws. 

Note: iBox Kits should be installed with the equipment modules and LEDs visible 
from the front of the rack. 

Note: Equipment cabling will typically route along the rack channel, come through 
a space above or below the iBox Kit then connect to the mounting panel, 
iBox, power supply, Ethernet Module and I/O module. 

Note: An IEC® 60947 compliant main disconnect switch (or other equivalent 
device complying with IEC 60947-1 / 60947-3) must be as electrically close 
as practicable to the iBox Kit power supply. 

You are now ready to connect ground, power, and communications cabling to the 
iBox Kit. 
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Connections 
Ground 
Connection 

Connect site ground to the iBox Kit protective earth terminal. We recommend 12 
AWG wire, a ring connector and a toothlock washer. 

 
 

 
 

Power 
Connection 

Connect power to the iBox Kit power supply. External fuse installation is required. 
Consult the power supply rating section for power ratings. 

 

 

iBox Kit (DC) 
Protective Earth 
Terminal 

DC Output 
Ground 

Input 

iBox Kit (AC) 
Protective Earth 
Terminal 

Not Connected 
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Communications Cabling 
Communi-
cations 
Cabling -
Ethernet 

If your iBox is equipped with an Ethernet module, connect the LAN to the iBox by 
plugging a CAT5 cable equipped with an RJ45 connector into the Ethernet module: 

 

 

Ethernet 
Port 
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Communications Cabling, continued 

Communic-
ations 
Cabling - 
Serial 

As necessary, connect the appropriate iBox COM port to your equipment using serial 
cables with male DB-9 connectors: 

 

Note: COM port assignments for different iBox Kit options are summarized in 
Appendix B: iBox Kit Default Configurations. 

Note: The Ethernet module is connected to the COM3 port by a special GE-
supplied cable (GE part number 977-0526.) 

 

WESMAINT 

COM 1 

COM 2 

COM 3 
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3.3. Configuring the iBox Kit Components 
Introduction Your iBox Kit modules have been pre-configured based on your order. However, 

you need to configure, or confirm the configuration of, the following items: 

iBox Kit Module Configurable Settings 

iBox • Project properties 

• Device properties 

• Communications properties 

• SCADA protocol addresses 

• PPP Driver (if applicable) 

• User ID and password 

Ethernet Module 
(if equipped) 

• IP addresses 

• Admin password 

• Pass-through switch 

• Configuration ports setting  

DC Analog Input 
Module (if equipped) 

In most cases, you will not have to reconfigure the DC 
Analog Input Module. You may, however, want to 
change the following: 

• Input type (voltage or current) 

• Input range  

• Point descriptors 

AC Analog Input 
Module (if equipped) 

In most cases, you will not have to reconfigure the AC 
Analog Input Module. You may, however, want to 
change the following: 

• Point descriptors 

Note: Configuration procedures vary for the iBox operating over a serial 
connection versus a LAN connection. Be sure to follow the appropriate set 
of procedures for your type of connection. 

Continued on Next Page 
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Configuring and Testing your iBox Kit Components, continued 

Before you 
Start 

To configure an iBox Kit with a serial connection, you will need: 

• Factory configuration for your iBox. You can find this on the configuration CD 
that shipped with your iBox Kit. 

• SGConfig installed on your PC. 

• Serial number of your iBox, from the iBox circuit board 

To configure an iBox Kit with a LAN connection, you will need, in addition to the 
above: 

• IP address/subnet mask of the LAN, iBox and Ethernet Module 

• Gateway address, if your iBox is connected to the LAN through a router. 

• Factory configuration for your Ethernet Module. You can find this on the 
configuration CD. 

 

Configuration 
Sequence –  
Serial  
Connection 

If you are operating the iBox Kit through a serial port, the process for configuring 
and testing the iBox Kit components is as follows: 

Restore Config Pro
Project

Configure AC or DC
Analog Input Module

(if equipped)

Download iBOX
configuration through

WESMAINT port

Configure iBOX
Device Properties for

serial connection

Configure Project
Properties for serial

connection

Configure iBOX
Communication

Options for serial
connection

Configure Application
Firmware

Test iBOX Kit

 

Continued on Next Page 
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Configuring and Testing your iBox Kit Components, continued 

Configuration 
Procedures – 
Serial 
Connection 

The procedures for configuring an iBox Kit with a serial connection are as follows: 

• Restoring your SGConfig Project on page 91 

• Configuring Project Properties - Serial on page 92 

• Configuring iBox Device Properties - Serial on page 94 

• Configuring iBox Communications Options - Serial on page 95 

• Configuring the Application Firmware on page 96 

• Downloading your iBox Configuration - Serial on page 97 

• Configuring the DC Analog Module on page 123 (if equipped) 

• Configuring the AC Analog Module on page 130 (if equipped) 

• Testing the iBox Kit on page 131 
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Configuring and Testing your iBox Kit Components, continued 

Configuration 
Sequence – 
LAN 
connection 

If you are operating the iBox Kit through a LAN, the process for configuring and 
testing the iBox Kit components is as follows: 

Restore Config Pro
Project

Configure Ethernet
Module

Configure AC or DC
Analog Input Module

(if equipped)

Download iBOX
configuration through

WESMAINT port

Configure iBOX PPP
Driver

Configure iBOX
Device Properties for

LAN Connection

Configure Project
Properties for LAN

Connection

Configure Application
Firmware

Configure iBOX
Communication
Options for LAN

Connection

Test iBOX Kit

 
Note: The first time you configure the iBox in an iBox Kit, you will do it through 

the WESMAINT serial port. Once you have configured the iBox, you will be 
able to download subsequent configurations over the LAN. 

 

Configuration 
Procedures – 
LAN 
connection 

The procedures for configuring an iBox Kit with a LAN connection are as follows: 
• Restoring your SGConfig Project on page 91 
• Configuring the Application Firmware on page 96 
• Configuring Project Properties  on page 98 
• Configuring iBox Device Properties - LAN on page 101 
• Configuring the iBox PPP Driver on page 103 
• Configuring iBox Communications Options - LAN on page 105 
• Downloading your iBox Configuration - LAN on page 108 
• Configuring the Ethernet Module on page 109 
• Configuring the DC Analog Module on page 123 (if equipped) 
• Configuring the AC Analog Module on page 130 (if equipped) 
• Testing the iBox Kit on page 131 
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Restoring your SGConfig Project 
 

Introduction This procedure describes how to restore the SGConfig project that includes the 
sample configuration provided with the iBox. 

 

Procedure:  
Restoring 
your 
SGConfig 
Project 

Step Action 
1  In your Windows desktop, click Start, and then click Programs. 
2  Click SGConfig, > SGConfig. 

Result: SGConfig opens. 
Importing the Factory Configuration 

3  Click GE > Archive > Project > Restore. 
4  Click Restore. 

Result: The Restore Project Details window appears: 

 

5  Insert your configuration CD in the drive. 
6  Navigate to the configuration file in the Archive File Name field. 
7  Click OK.  

Result: The configuration file uploads to your PC, and your project 
appears in an SGConfig project tab. 

 

 

Next Step If you are operating the iBox Kit through a serial connection, the next step is: 
• Configuring Project Properties - Serial on page 92 

If you are operating the iBox Kit through a LAN connection, the next step is: 
• Configuring Project Properties  on page 98 

Continued on next page 
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Configuring Project Properties - Serial 
Introduction Use the following procedure to configure Project Properties if you are operating the 

iBox Kit through a serial connection. 
 

Procedure:  
Configuring 
Project 
Properties - 
Serial 

Step Action 
1  In SGConfig, click GE > Project > Properties. 

Result: The Select Project window appears: 

 
2  Select your project under SGConfig Projects and click OK. 

Result: The Project Properties window appears: 

 
 

  Continued on next page 
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Configuring Project Properties - Serial, continued 

Procedure:  
Configuring 
Project 
Properties - 
Serial 
[continued] 

Step Action 

3  Select the D2x tab > General tab.  Verify that LAN Based Project is not 
checked and click OK. 

4  Click GE > Copy Project. 

Result: The Copy Project window appears:  

 
5  Type in a New Project Name for your project. 

6  Click OK to save. 
 

  

Next Step The next step is: 

• Configuring iBox Device Properties - Serial on page 94 
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 Configuring iBox Device Properties - Serial 
Procedure:  
Configuring 
iBox Device 
Properties - 
Serial 

Refer to “iBox Device Properties” on page 36 for instructions on configuring iBox 
Device Properties, when you are connecting to the iBox Kit through a serial port. 

 

Next Step The next step is: 

• Configuring iBox Communications Options - Serial on page 95 
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 Configuring iBox Communications Options - Serial 
Introduction Use the following procedure to configure iBox Communications Options if you are 

operating the iBox Kit through a serial connection. 
 

Procedure:  
Configuring 
Communi-
cations 
Options - 
Serial 

Step Action 

1  In the Project tab area, right-click the iBox device icon. 

2  Click Communications group > Options command. 

3  On the Interface tab, select Direct Serial under Connection Type and 
COM1 from the Comm Port list. 

 

4  Click OK to save. 
 

 

Next Step The next step is: 

• Configuring the Application Firmware on page 96 
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Configuring the Application Firmware 
Procedure: 
Configuring 
Application 
Firmware 

Refer to “Configuring Application Firmware” on page 40 for directions on how to 
configure iBox application firmware. 

 

Next Step If you are operating the iBox Kit through a serial connection, the next step is: 

• Downloading your iBox Configuration - Serial on page 97 

If you are operating the iBox Kit through a LAN connection, the next step is: 

• Downloading your iBox Configuration - LAN on page 108 
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Downloading your iBox Configuration - Serial 
Overview To download your iBox configuration file, connect your PC to the iBox 

WESMAINT port. 
 

Procedure:  
Downloading 
your iBox 
configuration 
through the 
WESMAINT 
port 

Refer to “Downloading your iBox Configuration” on page 41 for instructions on how 
to download a configuration file to the iBox through the WESMAINT port. 

 

Next Step If your iBox Kit is equipped with a DC Analog Input Module, the next step is: 

• Configuring the DC Analog Module on page 123 

If your iBox Kit is equipped with an AC Analog Input Module, the next step is: 

• Configuring the AC Analog Module on page 130 

If your iBox Kit is not equipped with a DC or AC Analog Input Module, the next 
step is: 

• Testing the iBox Kit on page 131 
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Configuring Project Properties - LAN 
Introduction Use the following procedure to configure Project Properties if you are operating the 

iBox Kit through a LAN connection. 
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Procedure:  
Configuring 
Project 
Properties - 
LAN 

Step Action 

1  In SGConfig, click GE > Project > Properties. 
Result: The Select Project window appears: 

 

2  Select your project under SGConfig Projects and click OK. 
Result: The Project Properties window appears: 

 
 

Continued on next page 
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Configuring Project Properties - LAN, continued 

Procedure:  
Configuring 
Project 
Properties - 
LAN 
[continued] 

Step Action 

3  Click the D2x > General tab. 

4  On the General tab, select LAN Based Project. 

5  Click the Segments tab. 

On the LAN A tab, select LAN A Enabled, and enter the IP Address and 
Subnet Mask.  

Note: Even if your LAN has a default gateway, you do not need to enter 
it here. 

6  Click OK to save. 
 

 

Next Step The next step is: 

• Configuring iBox Device Properties - LAN on page 101 
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Configuring iBox Device Properties - LAN 
Introduction Use the following procedure to configure iBox Device Properties if you are 

operating the iBox Kit through a LAN connection. 
 

Procedure:  
Configuring 
Device 
Properties - 
LAN 

Step Action 

1  Select the iBox device. 

2  Click Edit group > Properties command. 

Result: The iBOX Device Wizard appears. 

 

3  Verify LAN based device is selected. 

4  In the Description box, type in a name for the iBox. 

5  In the Serial Number box, type i the serial number of the iBox. 
 

Continued on next page 
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Configuring iBox Device Properties - LAN, continued 

Procedure:  
Configuring 
Device 
Properties 
- LAN  
[continued] 

Step Action 

6  Click the Processor tab. 

7  On the Memory Model tab, ensure that Derive From iBox Hardware 
Setting is selected. 

8  Confirm the settings are as shown above, and modify them if they are not. 

9  Click the LAN Settings tab, and then click the General tab. 

10  Confirm the settings are as shown above, and modify them if they are not. 

11  Click the LAN Specific tab: 

12  Enter the Host Address. 
Note: The Host Address is set to [(PPP IP Address of the Ethernet 

Module) + 1]. The iBox and Ethernet Module PPP IP addresses 
are related, as outlined in “IP Addressing” on page 81. 

Note: Do not change the Ethernet Address settings. 

13  Click OK to save. 
 

 

Next Step The next step is: 

• Configuring the iBox PPP Driver on page 103 
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Configuring the iBox PPP Driver and Internet Data Links 
Procedure:  
Configuring 
the PPP 
Driver 

Step Action 

1  Select the iBox device. 

2  Click Communications > Options. 

Result: The D2x Device Communication Options window > Interface tab 
appears. 

3  Select the PPP Connection Type. 

Result:  The tabs applicable to the connection type appear. 

4  Click the Tables tab.  

5  On the PPP main config tab, verify the following settings and modify 
them if necessary: 

Field Value 
Port COM3 
Baud 19.2K 
Bits per char 8 
Parity Type Even 
Parity Mode None 
Stop Bits 1 
RTS Disable 
CTS Disable 
DCD Enable 
RTS on delay 0 
DCD on delay 0 
RTS off delay 0 
Max PPP receive unit 1500 
Restart timer 3 
ACCM Disable 
CHAP Disable 
Challenge_retries 2 
Challenge_period 5 

Note: You should not need to change any of the above settings from 
their default values. If you do, you also need to make 
corresponding changes to the Digi One® Ethernet Module, if 
equipped, or to the equipment to which the iBox Ethernet port is 
connected. See “Configuring the Ethernet Module” on page 109. 

6  Close the PPP Driver window. 

7  Click Yes to save your changes. 
 

Continued on next page 
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Configuring the iBox PPP Driver and Internet Data Links, continued 

Procedure:  
Configuring 
the PPP 
Driver 
`(continued) 

Step Action 

8  On the Data Translation Applications tab, double-click the DNP 
Internet Data Link icon. 

Note: If your system uses the IEC 60870-5-104 data link, select the 
appropriate application icon. 

9  Click the Tables tab. 

10  In Local Host Name, enter *. 

11  Close the DNP Internet Data Link window. 

12  Click Yes to save your changes. 

13  Close the Applications window. 
 

 

Next Step The next step is: 

• Configuring iBox Communications Options - LAN on page 105 
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Configuring iBox Communications Options - LAN 
Introduction Use the following procedure to configure iBox Communications Options if you are 

operating the iBox Kit through a LAN connection. 
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Procedure:  
Configuring 
Communi-
cations 
Options - LAN 

Step Action 

1  In the Project window, right-click the iBox device icon, click 
Communications, and then click Options. 

2  On the Interface tab, click iSCS LAN and LAN A. 

 

3  Click the TFTP tab.  

 

4  Verify the settings are as shown above, and modify them if they are not. 

5  Click OK to save. 
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Configuring iBox Communications Options - LAN, continued 
Procedure:  
Configuring 
Communi-
cations 
Options - LAN 

Step Action 

6  Click Preferences > D2x/Generic System Preferences. 

Result: The SGConfig D2x/Generic System Preferences window 
appears: 

 

7  Click the Communications tab, then click the LAN tab. 

 

8  In LAN A, select from the list the source IP address that you will use to 
communicate with the iBox Kit over the LAN. 

9  Click OK. 
 

 

Next Step The next step is: 

• Configuring the Application Firmware on page 96 
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Downloading your iBox Configuration - LAN 
Introduction The first time you configure your iBox, you will need to connect your PC to the iBox 

WESMAINT port, as shown below: 

 

 

Procedure:  
Downloading 
your iBox 
configuration 
through the 
WESMAINT 
port 

Refer to “Downloading your iBox Configuration” on page 41 for instructions on how 
to download a configuration file to the iBox through the WESMAINT port. 

Note: Once you have configured the iBox PPP driver and the Ethernet Module, 
you will be able to download your iBox configuration over the LAN, as 
outlined in “Downloading your iBox Configuration over the LAN” on page 
136. 

 

Next Step The next step is: 

• Configuring the Ethernet Module on page 109 
 

iBOX Kit 

Ethernet 
Module 

PC running 
SGConfig 

LAN 

iBOX 

WESMAINT 
Port 
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Configuring the Ethernet Module 
Introduction The following procedure describes the configuration of the Digi One IAP Ethernet 

Module. 
 

Procedure:  
Configuring 
the Digi One 
IAP 

You need to set the Digi One Ethernet and PPP IP addresses. Refer to “IP 
Addressing” on page 81 for an explanation. You also need to change the Digi One 
root password. 

Step Action 

Connecting to the Digi One 

1  Connect a PC to the Digi One IAP’s RJ45 connector either directly, as 
shown below: 

iBOX Kit

Digi One
IAP

PC running
a Web browser, IP address in

the same subnet as the
Ethernet Module

Crossover Ethernet
Cable  

or through the network: 

iBOX Kit

Digi One
IAP

PC running
a Web browser, IP address in

the same subnet as the
Ethernet Module

Straight-through
Ethernet Cable

LAN

 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

Configuring your PC’s Proxy Settings (Windows 2000) 

If your PC is configured to use a proxy server, follow the procedure below to add 
the Digi One IP address to Exceptions so you can browse directly into the Digi 
One Web server.  

Note: The procedure may vary for Windows XP. 

2  Click Start, point to Settings, and then click Control Panel. 

3  Double-click the Internet Options icon. 

4  Select the Connections tab. 

5  Click LAN Settings. 

6  Do one of the following: 

• If Use a proxy server for your LAN is not selected, you do not have 
to make any further changes to your Proxy Settings. Close all 
Windows dialog boxes and proceed to “Modifying IP Addresses in 
the Digi One Configuration File”. 

• If Use a proxy server for your LAN is selected, proceed to the next 
step. 

7  In Proxy Server, click Advanced. 

Result: The Proxy Settings dialog box appears: 

 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

8  In Exceptions, add the default Digi One Ethernet IP address, 
192.168.1.100. 

Note: You can use the wildcard character (*) to specify a range of IP 
addresses; for example, if you enter 192.168.*, all messages sent 
to IP addresses starting with 192.168 will be sent directly, not 
through the proxy server. 

Note: Once you change the Digi One Ethernet IP address, you will have 
to modify Proxy Settings accordingly.  

9  Click OK and close all windows. 

Changing Pass Through Switch Settings 

10  Locate the pass-through switch on the bottom of the Digi One IAP  

 
Change the switch setting from the default state OFF to ON 

11  Reboot the Digi One IAP. Refer to steps 1 to 4 in Appendix C: Resetting 
the Digi One Configuration. 

 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

Modifying the Ports Setting in the Digi One Configuration File 

12  Copy the Digi One default configuration file from the configuration CD to 
a folder on your PC’s hard drive.  This file can be found as follows 
\ Digi Default Config \ Digi Default Config.txt 

13  Open the Digi One default configuration file in a text editor such as 
Notepad 

14  Search for all instances of ports=1 and replace with ports=2.  There 
should be 4 changes. 

Modifying IP Addresses in the Digi One Configuration File 

15  Near the top of the configuration file, change the Ethernet IP address, 
subnet mask, and gateway address. 

Note: If a gateway is not used, set the gateway address to the Digi One 
Ethernet IP address. Refer to “IP Addressing” on page 81 for an 
explanation of iBox Kit IP addressing. 

Example: If the Digi One Ethernet IP address is 192.168.1.100 and a 
gateway is not used change the following lines in the 
configuration file: 

  set config ip=192.168.1.100 submask=255.255.255.0 
  set config gateway=192.168.1.100 

16  Modify the Digi One’s PPP IP address. Refer to “IP Addressing” on page 
81 for an explanation of the Digi One’s PPP IP address setting. 

Example: In the following example, the PPP IP address is set to 
192.168.1.19: 

  set user name=”link1” localipaddr=192.168.1.19 netrouting=off 

In this example, the iBox IP address will automatically be set to 
192.168.1.20 (192.168.1.19 + 1) over PPP. 

17  Save the modified configuration file as DigiDefaultConfig_Modified.txt. 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

Starting the Digi Device Setup Wizard 

18  Insert the Digi Software and Documentation CD in your CD ROM drive. 
Result: The Digi Device Setup Wizard starts automatically: 

 

19  Click Next. 

Result: The Setup Wizard discovers Digi devices on the LAN, and 
presents a list of the discovered devices: 

 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

20  Select your device.  
Note: The MAC address of your Digi One IAP is located on the white 

label on the bottom or back of the device. 

21  Click Next. 

Result: The Configure Network Settings page appears: 

 

Configure the Digi One IP Settings 

22  Select Use the following IP settings. 

23  Enter the Digi One Ethernet IP address and subnet mask, as shown in the 
above example. Enter a gateway address if one is required. Check with 
your network administrator if you are not sure. 

 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

24  Click Next. 

Result: The Select Scenario page appears: 

 

Downloading the Configuration to the Digi One 

25  In the drop-down list under Scenario List, select Custom Configuration. 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

26  Click Next. 

Result: The Verify Configuration page appears: 

 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

27  Do one of the following: 

• If the configuration parameters are not correct, click Back and make 
the necessary corrections. 

• If the configuration parameters are correct, click Next. 

Result: The Setup Wizard saves the network settings to the Digi 
One, and then reboots the device: 

 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

Connecting to the Digi One Web Server 

28  When the reboot completes, the Saved configuration successfully screen 
appears:  

  

29  Make sure Register my Digi One IAP on the Digi website is not 
selected, and click Finish. 

Result: The Enter Network Password dialog box appears: 

 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

30  Enter User Name root and Password dbps and click OK. 

Result: The Digi One IAP Configuration and Management home 
page appears: 

 
 

Continued on next page 



iBox/iBox Kit  
Installation and Maintenance Guide GE Grid Solutions 
 

120 994-0047-5.10-4 GE Information 

 

Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

Downloading the Configuration File to the Digi One 

31  Under Administration, click Backup/Restore. 

Result: The Backup/Restore page appears: 

 

32  Click Browse and enter the location of the Digi One configuration file on 
your PC. 

33  Click Restore. 

Result: The Digi One receives the configuration file from your PC. 

34  Click Done. 

Result: The Reboot page appears.  

Note: The Digi One IAP needs to be rebooted for the new configuration 
settings to be applied. 

35  Click Reboot. 

Result: The Digi One reboots. 
 

Continued on next page 
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Configuring the Ethernet Module, continued 

Procedure:  
Configuring 
the Digi One 
(continued) 

Step Action 

36  To confirm that it is correctly configured, ping the Digi One through the 
DOS command line. 

37  Under Configuration, click Security. 

Result: The Security Configuration dialog appears: 

 
38  Enter and confirm your new administrator password and click Apply.  

Note: The next time you browse to the Digi One Web server, you will 
need to enter user name root and this new password. If you forget 
this password, you can reset the Digi One to its default 
configuration and password (user name root, password dbps), by 
following the procedure outlined in “Resetting the Digi One 
Configuration” on page 153. If you reset the Digi One, you will 
need to reconfigure it using the procedure outlined in this section. 

Note: You will now be able to configure the Digi One through its Web 
server. Refer to the Digi One User’s Guide, which you can obtain 
from the Digi Software & Documentation CD. 
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Configuring the Ethernet Module, continued 

Next Step If your iBox Kit is equipped with a DC Analog Input Module, the next step is: 

• Configuring the DC Analog Module on page 123 

If your iBox Kit is not equipped with a DC Analog Input Module, the next step is: 

• Testing the iBox Kit on page 131 
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Configuring the DC Analog Module 
Overview The ADAM®-4017+ DC Analog Input Module has been pre-configured based on 

your order. Typically, all of the analog inputs will be configured the same way; for 
example, they may all be configured to have a voltage range of  +1 V. 

In most cases, you will not have to reconfigure the DC Analog Input Module. You 
may, however, want to change the following: 
• Input type (voltage or current) 
• Input range  
• Point descriptors 

The following procedure is intended as a high-level overview. For detailed 
instructions and settings, refer to the following documents: 

• ADAM 4000 Data Acquisition Modules User’s Manual – Available from the 
Advantech CD that shipped with your iBox Kit (accessible through Manual > 
ADAM 4000 > ADAM-4000.pdf) 

• Modbus®DCA Configuration Guide (A059-0CG) – Available from the GE 
Digital Energy CD that shipped with your iBox Kit 

• Calculator DTA Configuration Guide (A083-0CG) – Available from the GE 
Digital Energy CD that shipped with your iBox Kit  

 

Before you 
Start 

You need the following to configure the ADAM-4017+: 

• RS-485/RS-232 converter 

• Cables to connect the RS-232 side of the converter to your PC COM port, and 
the RS-485 side of the converter to your ADAM-4017+ DATA+ and DATA- 
terminals. 

• Phillips screwdriver, to disconnect field and communications wires to the 
ADAM-4017+. 

• Needle-nose pliers to make jumpering changes, in the event that you want to 
change the input types from voltage to current, or vice versa. 

• PC equipped with: 
− ADAM-4000 Utility, available from the Advantech CD that shipped with 

your iBox Kit 

− SGConfig, available from the GE Digital Energy CD that shipped with your 
iBox Kit. 
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Configuring the DC Analog Module, continued 

Procedure: 
Configuring 
the ADAM-
4017+ 

If you want to change the configuration of some or all of the analog inputs, follow 
the procedure below. If necessary, refer to the procedures in the vendor’s manual. 
     

 Step Action 

1  Power down the iBox Kit. 

2  Disconnect the cable between the ADAM-4017+ and iBox COM2, at the 
ADAM-4017+ end. 

3  Connect the RS-485 side of the RS-485/RS-232 converter to the DATA+ 
and DATA- terminals on the ADAM-4017+. Connect the RS-232 side of 
the converter to one of your PC’s COM ports. 

PC running
ADAM-4000

Utility
ADAM-4017+ RS-485/RS-232

Converter

RS-485 RS-232

 
4  Switch the operating mode of the ADAM-4017+ from Normal to Init, 

then restore power to the unit: 

 

    

Continued on next page 

Init/Normal 
Switch 



GE Grid Solutions iBox/iBox Kit 
Installation and Maintenance Guide 

 

 

GE Information 994-0047-5.10-4 125 

 

Configuring the DC Analog Module, continued 

Procedure: 
Configuring 
the ADAM-
4017+ 
(continued) 

Step Action 

5  Install the ADAM-4000 utility from the Advantech CD (accessible 
through Install Products > ADAM-4000 Utility).  

6  Open the ADAM-4000 Utility: 

 
Result: The ADAM Utility Main Screen appears: 

 
    

Continued on next page 
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Configuring the DC Analog Module, continued 

Procedure: 
Configuring 
the ADAM-
4017+ 
(continued) 

Step Action 

7  In the left-hand pane, select the COM port to which the ADAM-4017+ is 

connected, and click Search (  ) in the toolbar.  
Result: The Search Installed Modules dialog box appears: 

 

8  Click OK.  

Result: The ADAM-4000 Utility searches for and displays devices on 
the COM port. 

9  As soon as your ADAM 4017+ is displayed in the left-hand pane, click 
Stop scan to halt the device search: 

 
    

Continued on next page 
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Configuring the DC Analog Module, continued 

Procedure: 
Configuring 
the ADAM-
4017+ 
(continued) 

Step Action 

10  Select the ADAM-4017+ device in the left-hand pane. 

Result: The ADAM-4017+ configuration displays in the right-hand 
pane: 

 

11  Make the desired changes.  

Note: You can change the characteristics of individual analog points, or 
make the same change to all analog points. Refer to the ADAM-
4000 Utility Online Help for further information. To access this 
online help, your PC must be connected to the Internet.  

Note: If you are changing the ADAM-4017+ input range from voltage to 
current, or vice versa, you will need to power down the device, 
remove its cover, and change the jumper setting for the analog 
input(s). For detailed instructions and settings, refer to the ADAM 
4000 Data Acquisition Modules User’s Manual – Available from 
the Advantech CD that shipped with your iBox (accessible 
through Manual > ADAM 4000 > ADAM-4000.pdf) 

 

Continued on next page 
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Configuring the DC Analog Module, continued 

Procedure: 
Configuring 
the ADAM-
4017+ 
(continued) 

Step Action 

12  Click Update, then OK when you receive the message that the setup was 
successful: 

13  Remove power to the ADAM-4017+. 

14  Change the ADAM-4017+ operating mode switch from Init back to 
Normal. 

15  Restore power to the ADAM-4017+. 

16  In the ADAM-4000 Utility, click .  
Result: The device configuration is now consistent with the change or 

changes you made. 

17  Remove power to the ADAM-4017+. 

18  Disconnect the ADAM-4017+ from the RS-485/RS-232 converter, and 
reconnect it to the iBox. 

 

 

Procedure: 
Modifying the 
Point 
Descriptors 

You may wish to modify the default point descriptions for the DC Analog Inputs to 
more meaningful descriptions for your system. Follow these steps to change the 
point descriptors of the DC analog inputs. 

 Step Action 

1  Open the iBox Kit device in SGConfig, open the Applications List, and 
click the System Point Database Applications tab. 

2  Double-click the System Point Database icon. 

Result: The System Point Database Properties window displays. 

3  On the DCA/DTA List tab, select MODBUS DCA and click the 
Descriptors button. 

Result: The Point Descriptors window appears. 

4  Click the Analog Inputs tab on the bottom of the window. Enter new 
Point Descriptions as desired. Click OK. 

5  On the DCA/DTA List tab, select Calculator DTA and click the 
Descriptors button. 

Result: The Point Descriptors window appears. 

6  Click the Analog Inputs tab on the bottom of the window. Enter new 
Point Descriptions as desired. Click OK twice. 

Result: SGConfig updates the configuration tables. 
 

 

 
 



GE Grid Solutions iBox/iBox Kit 
Installation and Maintenance Guide 

 

 

GE Information 994-0047-5.10-4 129 

 

Configuring the DC Analog Module, continued 

Next Step If your iBox Kit is equipped with a AC Analog Input Module, the next step is: 

• Configuring the AC Analog Module on page 130 

If your iBox Kit is not equipped with a AC Analog Input Module, the next step is: 

• Testing the iBox Kit on page 131 
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Configuring the AC Analog Module 
Overview In most cases, you will not have to reconfigure the AC Analog Input Module. You 

may, however, want to change the Point descriptors 

The following procedure is intended as a high-level overview. For detailed 
instructions and settings, refer to the following documents: 

• DMMS300+, DMMS350, DMMS425 3-Phase Multifunction Power Monitors 
with Advanced Capabilities Installation, Operation and Programming Manual 
(Electro Industries/GaugeTech) that shipped with your iBox Kit  

• Modbus DCA Configuration Guide (A059-0CG) – Available from the GE Digital 
Energy CD that shipped with your iBox Kit  

 

Before you 
Start 

You need the following to configure the DMMS module: 

• PC equipped with SGConfig, available from the GE Digital Energy CD that 
shipped with your iBox Kit. 

 

Procedure: 
Modifying the 
Point 
Descriptors 

You may wish to modify the default point descriptions for the AC Analog Inputs to 
more meaningful descriptions for your system. Follow these steps to change the 
point descriptors of the AC analog inputs. 

 Step Action 

1  Open the iBox Kit device in SGConfig, open the Applications List, and 
click the System Point Database Applications tab. 

2  Double-click the System Point Database icon. 

Result: The System Point Database Properties window displays. 

3  On the DCA/DTA List tab, select MODBUS DCA and click the 
Descriptors button. 

Result: The Point Descriptors window appears. 

4  Click the Analog Inputs tab on the bottom of the window. Enter new 
Point Descriptions as desired.  

5  Click the Counters tab. Enter new Point Descriptions as desired. Click 
OK twice. 

Result: SGConfig updates the configuration tables. 
 

 

Next Step The next step is: 

• Testing the iBox Kit on page 131 
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Testing the iBox Kit 
Overview You can verify the iBox Kit is operating properly by: 

• Inspecting the LEDs on each of the iBox Kit components, and  

• Pinging the Ethernet Module and the iBox from your PC 
 

Digi One IAP 
LEDs 

When operating normally, the Digi One LEDs appear as follows: 

LED Normal Operation 

POWER Solid GREEN 

LINK Solid GREEN 

DCD Solid GREEN 

DSR Solid GREEN 

DTR Solid GREEN 

RTS Solid GREEN 

TX Flashing GREEN 

RX Flashing GREEN 
 

 

ADAM-4017+ 
LEDs 

The ADAM-4017+ has a single GREEN LED, which operates as follows: 

LED Operation Description 

OFF Power OFF 

GREEN Solid Power ON, unit is not being polled over the 
Modbus interface. 

GREEN Flashing Power ON, unit is being polled over the Modbus 
interface at the same rate as the LED is flashing. 

 

 

DMMS LEDs Refer to the manufacturer’s manual. 
 

iBox LEDs For information on iBox LED operation, refer to: 

• “LEDs” on page 32 (for LED operation during self diagnostics) 

• “LED Descriptions” on page 46 (for normal LED operation) 

• “Errors Indicated by LEDs” on page 74 (for information on using LED 
indications to troubleshoot iBox problems) 

 

Pinging the 
Ethernet and 
iBox 

If the iBox Kit modules are operating correctly, and it is configured for LAN 
connection, you will be able to ping the Ethernet Module and iBox IP addresses from 
your PC. 
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3.4. Connecting Field Wiring 
Digital Inputs 
and Outputs 

Digital inputs and outputs are connected directly to the iBox. Refer to “Connecting 
and Testing Field Wiring” on page 51 for information on how to connect field wiring 
to the iBox, and how to map and test these connections. 

 

AC Analog 
Inputs 

AC analog inputs are connected to the iBox Kit through the AC Analog Input 
module, as shown below: 

 

Three-Phase Four-Wire Wye with Direct Voltage and CTs 

 

 

Three-Phase Four-Wire Wye with CT and PTs 

Continued on Next Page 
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Connecting Field Wiring, continued 

DC Analog 
Inputs 

DC analog inputs are connected to the iBox Kit through the DC Analog Input 
module, as shown below: 

Vin 4-
Vin 4+
Vin 3-
Vin 3+
Vin 2-
Vin 2+
Vin 1-
Vin 1+
Vin 0-
Vin 0+

Vin 5-
Vin 5+

Vin 6-
Vin 6+

Vin 7-
Vin 7+
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3.5. Servicing your iBox Kit 
Overview This section provides information about servicing your iBox Kit, in particular: 

• Servicing the iBox 
• LED operation 
• Location of fuses 
• Updating your iBox configuration 

 

Procedure: 
Servicing the 
iBox 

For instructions on how to service the iBox, refer to “Servicing your iBox” on page 
58. 

 

Connections The other modules in the iBox Kit require very little servicing. Verify that 
connections are tight, and LEDs are operating correctly. 

 

LED 
Operation 

For information on the operation of LEDs on iBox components, refer to the 
following sections of this document: 

• iBox LEDs (refer to “LED Descriptions” on page 46) 

• Digi One IAP LEDs (refer to “Digi One IAP LEDs” on page 131) 

• ADAM-4017+ LEDs (refer to “ADAM-4017+ LEDs” on page 131) 

• DMMS LEDs (refer to the manufacturer’s manual) 
 

Procedure: 
Replacing 
Fuses 

For information on the location and replacement of iBox fuses, refer to “Fuse 
Replacement” on page 59. 
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3.6. Maintaining your iBox Kit Software 
Overview The iBox software may need occasional maintenance. Although other modules may 

also contain firmware, this firmware will typically not need to be upgraded. 
 

Maintaining 
your iBox 
Software 

For information about your iBox software and instructions on how to maintain it, 
refer to “Maintaining your iBox Software” on page 61. 
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Downloading your iBox Configuration over the LAN 
Introduction Once you have configured the iBox PPP Driver and Ethernet Module, you can 

download subsequent changes to the iBox configuration over the LAN. To do this, 
configure your PC with an IP address in the LAN’s subnet. This is illustrated below: 

iBOX Kit

Ethernet
Module

PC running
Config Pro, with IP
address in iBOX

Kit subnet

LAN

iBOX

 

Note: Refer to Appendix D: Setting your PC IP Address for instructions on how to 
set your PC’s IP address (for Windows 2000). 
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Downloading your iBox Configuration over the LAN, continued 

Procedure:  
Downloading 
your iBox 
Configuration 
over the LAN 

To download an iBox configuration file over the LAN: 

Step Action 

1  In the Project window, click the iBox device icon. 

2  Open the Terminal Emulator; see the SGConfig online help topic: Open 
Terminal Emulator. 

Result: SGConfig opens a Terminal Emulator tab. 

3  Log into WESMAINT. 

Result: The WESMAINT main menu appears. 

4  Select option 2, System Functions. 

Result: The System Functions menu appears. 

5  Select option 3, 68K Monitor. 

Result: The system prompt appears, indicating that the Applications 
Monitor is running. 

6  At the system prompt, type rtb and press ENTER. 

For other available commands, type help and press ENTER. 

7  At the Return to the BootROM Operating System? (yes/no) prompt, 
type yes and press ENTER. 

Note: The monitor is not case sensitive, but Y is not acceptable. 

Result: The iBox restarts. 

8  In SGConfig, open the project containing the iBox device. 

9  In the project window, right-click the iBox device icon, click 
Communications, and then click Configuration Download. 

Result: SGConfig downloads the new configuration to the iBox. 
SGConfig displays progress messages until the new 
configuration has been successfully downloaded.  

Note: The iBox does not need to be rebooted for the new configuration 
to be effective. 

10  Exit SGConfig. 
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3.7. Troubleshooting your iBox Kit 
Overview The LED indicators on each iBox Kit device can be used to troubleshoot most iBox 

Kit problems. If device configuration files are those supplied with the iBox Kit, most 
problems are the result of failed cabling or connection. 

 

iBox If you are experiencing general problems or are unable to isolate a problem to a 
particular iBox Kit module, the problem may lie with the iBox unit. For iBox 
troubleshooting guidelines, refer to “Troubleshooting your iBox” on page 69. 

 

Network 
Connection 

If you are having problems connecting to the network, check the operation of the 
Ethernet Module. The following table shows normal LED operation for the Digi One 
and provides suggestions for corrective action if LED operation is not normal. 

LED Normal Operation Suggestions 

POWER Solid GREEN Check power supply/connections 

LINK OFF RED LED indicates no network/cabling 

DCD Solid GREEN Check cabling connections/serial port 

DSR Solid GREEN Check cabling connections/serial port 

DTR Solid GREEN Check cabling connections/serial port 

RTS Solid GREEN Check cabling connections/serial port 

TX Flashing GREEN Check cabling connections/serial port 

RX Flashing GREEN Check cabling connections/serial port 
 

 

ADAM 4017+ If you are having a problem with DC analog inputs, check the operation of the 
ADAM-4017+. The following table shows normal LED operation for the ADAM 
4017+ and provides suggestions for corrective action if LED operation is not normal. 

LED Description Suggestions 

OFF Power OFF Check power supply/connections 

Solid GREEN Power ON, no polling Check cabling if it should be polled 

Flashing 
Green 

 Power ON, MODBUS polling Check cabling if it should not be 
polled 

 

 

Configuration Changes to the iBox configuration file may result in incorrect operation. If you are 
unable to isolate the problem by inspecting the LEDs and by checking unit cabling, 
verify the iBox configuration file against Appendix B: iBox Kit Default 
Configurations and modify if appropriate. 

 

 



GE Grid Solutions iBox/iBox Kit 
Installation and Maintenance Guide 

 

 

GE Information 994-0047-5.10-4 139 

 

3.8. Replacing your iBox Kit 
Procedure: 
Replacing an 
iBox Kit 

To replace an iBox Kit: 

Step Action 

1 Disconnect the communication cables from the iBox Kit. 

2 Disconnect all field wiring from the iBox Kit. 

Tip: Make sure you label these connections carefully, so you can 
restore them once the replacement unit is installed. 

3 Remove power cabling. 

4 Disconnect the ground wire from the iBox Kit. 

5 Fully unscrew the lower mounting screws. Loosen the upper mounting 
screws, then raise and remove the iBox Kit from the rack. 

6 Check the jumpers and settings on the replacement iBox Kit and make 
sure they are the same as those on the failed unit. 

7 Mount the replacement iBox Kit in the rack. Insert the lower mounting 
screws, and tighten all mounting screws. 

8 Reconnect the ground wire to the iBox Kit. 

9 Reconnect power cabling. 

10 Reconnect all field wiring, exactly as it was connected previously. 

11 Reconnect the communication cables. 

12 Verify that the replacement iBox Kit indicators are functioning properly. 
Refer to “LED Operation” on page 134 

13 Test your iBox Kit inputs and outputs, using the procedures outlined in 
“Connecting Field Wiring” on page 132. 

14 Return the failed iBox Kit to GE Digital Energy, following the product 
return procedures. 
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Section 4: Removing Configuration Data and 
Sensitive Information 

Overview In the event that it is necessary to remove the configuration data and sensitive information 
from the iBox (for example, the iBox is being disposed of or being returned for 
maintenance [i.e., RMA]), this section provides the data removal procedure.  

It may also be necessary to remove data from a PC that has run SGConfig for the purpose 
of configuring a iBox. Again, this section provides the data removal procedure. 

 

4.1. From the iBox Device 
Method The configuration data can be removed from these devices by either: 

• Removing the battery from the device for at least 5 minutes. 
Result: The configuration data which was backed up in NVRAM is removed, since 
the NVRAM is powered by a battery. 
Note:  This does not remove the firmware running in the flash memory. 

    OR 

• Restarting the device: 

1. Restart the device by either: 
• Turning the power off and on, or 
• Typing the boot command at the 68K monitor prompt. 

2. When messages appear on the 68k monitor prompt, press the Esc key a few 
times within 5 seconds.  
Result: The message: “Are you sure you wish to generate a default 
configuration? (y/n)” appears. 

3. Type y (or Y).   

Result: The current configuration file is overwritten with the default 
configuration. The 68k monitor is initiated. The configuration has been defaulted 
to a factory-based configuration and the user’s configuration has been deleted. 

4. Remove the firmware from the flash memory: 
a. Login to the device through the 68K monitor (if not already logged in).  
b. Type sp to suspend all processes running on the device.  
c. Type erase to clear the flash.  

Result: This takes several seconds to complete.  
Result: The Flash Erased message appears when the erase operation is 
completed.  

5. Confirm the flash has been erased by typing img at the prompt to view the image 
file.  
Result:  No firmware information should appear. 
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4.2. From the PC Running Configuration Software 
Method If SGConfig have been used to configure the iBox processor, configuration data 

resides on the data storage media (e.g., hard drives, memory cards, etc.) of the PC 
running SGConfig.  

The iBox configuration data can be removed from the PC by either: 

• Recommended:   Physically removing and destroying the data storage media, 
or  

• Using a program to securely wipe (i.e., completely erase) the data storage 
media; that is, not just reformat or remove the names of the files from the file 
allocation table. 
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Appendix A: Technical Specifications 

iBox 
Power 
Requirements 

Power Supply Input Options    20-60 Vdc 

 Power Consumption 7 Watts (maximum) 

 Inrush Current Less than 0.5A peak 

 Power Supply Protection Input fuse 

Reverse polarity protection provided 
  

Communi-
cation Ports 

Maintenance Port WESMAINT DB-9-F, EIA 232 @ 9600 bps 

 Standard Serial Communication 
Ports (3) 

DB-9-F, EIA 232/485 up to 38400 bps (concurrently) 
Software configurable 
Jumper selectable (JP3) Radio Key output on Port 1 
36 Vdc max., 3 A peak max., 0.1 sec ON, 10% duty 
cycle 

 UTC Time Port  
(in place of one serial port) 

DB-9-F, EIA 232 Port 2 

 

Digital Inputs General  Up to eight bipolar optically isolated (2000 Vrms) 

 Burden From 1.9 mA to 5.5 mA  
max. power dissipation is 0.5 W per input 

 Wetting Options External wetting - for all input options 
Modes of operation:  
Dry contact and voltage sense 
24 Vdc, 48 Vdc, and 110/125 Vdc 

Continued on next page 
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Technical Specifications – iBox, continued 

Digital 
Outputs 

General  Up to four relay outputs: 4 Trip/Close pairs or 2 
Trip/Close pairs and 2 Form A contacts 

 Security features Separate Master Trip and Master Close relays 
Single point of failure integrity, select-before-
operate (SBO) functionality. Remote/Local jumper 
JP2. 

 Control Voltage  External 

 Switching Characteristics 35 W breaking @ 150 Vdc 
180 W breaking @ 30 Vdc 

 Maximum Carrying Current 6 A 

 

Size and 
Environment 

Dimensions Width (of Mounting 
Panel) 

28 cm (11 inch) 

Height 19 cm (7.5 inch) 

Depth 4.5 cm (1.75 inch) 

Weight 1 kg (2.2 lb) maximum 

Operating Temperature -40° to +80°C, may exceed EN61010-1 metal 
enclosure temperature of +70° C at ambient 
temperature of +60°C. 

Storage Temperature -40° to +90°C 

Humidity Rating 0 to 95% relative humidity, non-condensing 

Operating Altitude 0 to 2000 meters 

Environmental Rating IP20 

Installation (Overvoltage) 
Category 

CAT II EN61010-1 

Note: Must be installed in an overall protective 
enclosure and/or a protective environment unless 
the power supply terminals have a protective cover 
installed 

Pollution Degree 2 

 IEC 68-2-1 Cold 

 IEC 68-2-2 Dry heat 

 IEC 68-2-6 Vibration 

 IEC 68-2-30 Damp heat, cyclic (12+12-hour cycle) 

 MTBF > 74000 hours @ 40°C 

Note: Increased operating temperature decreases 
MTBF of the device 

Continued on next page 
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Technical Specifications – iBox, continued 

EMI/EMC 
Compliance 

CISPR11  Limits and methods of measurement of 
electromagnetic disturbance characteristics of 
industrial, scientific and medical (ISM) radio-
frequency equipment. 

 EN61000-4-2 Immunity Test 

 EN61000-4-3 Radiated, radio-frequency, electromagnetic field 
immunity Test 

 EN61000-4-4 Electrical Fast Transient/Burst Immunity Test 

 EN61000-4-5 Surge Immunity Test 

 EN61000-4-6 Immunity to conducted disturbances induced by 
radio-frequency fields  

 EN 61000-4-12 Damped Oscillatory Wave Immunity Test (100 kHz/1 
MHz) 

 EN 61010-1 Safety Requirements For Electrical Equipment For 
Measurement, Control and Laboratory Use - Part 1: 
General Requirements. 

 EN60255-5 Dielectric Test 
Impulse Voltage Test 
Insulation Resistance 

 EN61000-4-16 Test for Immunity to Conducted, Common Mode 
Disturbances in the Frequency Range 0 Hz to 150 
kHz (steady state frequency) 

 IEEE C37.90.1-1989 SWC capability 

   

Field 
Terminations 
& Wiring 

Digital Outputs 250 V rated compression termination consisting of a 
header and removable plugs suitable for 12 – 24 
AWG wire rated for 6A/150V 

Power Supply Inputs 250 V rated compression termination consisting of a 
header and removable plugs suitable for 12 – 24 
AWG wire 0.5A/60V 

Digital Inputs 250 V rated compression termination consisting of a 
header and removable plugs suitable for 12 – 24 
AWG wire 0.01A/150V 

Protective Earth Terminal #10 fastener 

Note: Ground wire must be the largest gauge of all 
wires used for field termination. A green and 
yellow 12 AWG wire is recommended. 
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iBox Kit 
Physical 

Dimensions 
8.75” high x 19” wide x 2” deep 
(22.23 cm high x 48.26 cm wide x 5.08 cm deep) 

Mounting 19” rack mounting 

Operational 
Temperature 

iBox: -40° to +80°C 
DC Analog Module: -10° to +70°C 
AC Analog Module: -20° to +70°C 
Ethernet Module: 0° to +60°C 
Power Supply: -40° to +80°C 

Storage Temperature -40° to +90°C 

Humidity Rating 95% non-condensing at 55°C 

Operating Altitude 0 – 2000 meters 

Protective Earth 
Terminal 

Protective earth terminal is provided on the mounting 
plate 

 

 

Power Supply Input Voltage Options 20-60 VDC or 88-264 VAC/88-300 VDC 

Output Voltage 24 VDC 

Overload Protection Current limiting with short circuit protection 

Connections Screw-type terminal block 
 

 

iBox 
Communi-
cation Ports 

Maintenance Port DB-9-F, EIA 232 @ 9600 bps 

Standard Serial Comm-
unication Ports (3) 

• DB-9-F, EIA 232/485 up to 38400 bps (concurrently) 
• Software configurable 
• Jumper selectable (JP3) Radio Key output on Port 1 
• 36 VDC max, 3 A peak max, 0.1 sec ON, 10% duty 

cycle 
 

 

Ethernet 
Interface 
(optional) 

Port Type 100BaseTX 

Speed 10/100 Mbps 

Connector RJ-45 
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Technical Specifications – iBox Kit, continued 

Digital Inputs General  Up to eight bipolar optically isolated (2000 Vrms) 

Physical 
250 V rated compression termination consisting of a 
header and removable plugs suitable for 12 – 24 AWG 
wire 0.01A/150V 

Burden 
• From 1.9 mA to 5.5 mA 
• Max. power dissipation is 0.5 W per input 

Wetting Options 

• External wetting - for all input options 
• Modes of operation:  

− Dry contact and voltage sense 
− 24 VDC, 48 VDC, and 110/125 VDC 

 

 

Digital 
Outputs General  

Up to four relay outputs, configured as either: 
• 4 trip/close pairs or 
• 2 trip/close pairs and 2 Form A contacts 

Physical Connection 
250 V rated compression termination consisting of a 
header and removable plugs suitable for 12 – 24 AWG 
wire rated for 6A/150V 

Security features 

• Separate Master Trip and Master Close relays 
• Single point of failure integrity, select-before-operate 

(SBO) functionality. 
• Remote/Local jumper JP2 

Control Voltage  External 

Switching Characteristics 
• 35 W breaking @ 150 VDC 
• 180 W breaking @ 30 VDC 

Maximum Carrying 
Current 

6 A 

 

Continued on next page 
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Technical Specifications – iBox Kit, continued 

AC Analog 
Inputs 
(optional) 

Analog Input Options 
VRMS, IRMS, Phase Angle, Frequency, Power Factor, Real 
Power (W), Reactive Power (VAR), Apparent Power (VA), 
Watt-Hour 

Nominal PT Input Range 0 to 150VLN or 250VLL 

Frequency 50/60 Hz 

Measurement Range 0 to 125% of nominal 

Accuracy 0.3% 

Continuous Overload 
Withstand 200% of nominal 

Short Duration Overload 
Withstand 100 A for 3 seconds 

Surge Withstand As per IEEE C37.90.1, ANSI C62.41 

True RMS Sampling 64 samples per cycle 

Isolation 2500 VAC/60 Hz 

Burden 
• Voltage and Current: 0.1 VA max 

• Power Supply: 6 VA max 
 

 

DC Analog 
Inputs 
(optional) 

Analog Input Options Two DC analog inputs, or eight DC analog inputs 

A/D Resolution 14 bits plus sign 

Nominal DC Voltage 
Input Range Options ±1 VDC, ±5 VDC or ±10 VDC 

Nominal DC Current 
Input Range Options ±20 mA or 4-20 mA 

Accuracy ±0.2% of full scale @ 25oC 
 

 



GE Grid Solutions iBox/iBox Kit 
Installation and Maintenance Guide 

 

 

GE Information 994-0047-5.10-4 149 

 

Appendix B: iBox Kit Default 
Configurations 

When shipped as part of an iBox Kit, the iBox COM port default configurations are set to one of the 
following: 

iBox (IBOX-BSC1) 
 Configuration Details Comments 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: COM1 
Baud Rate: 9600 
Communication Type: RS-232 

Refer to point map tables for more detail. 

Modbus DPA 

Modbus Address: 1 
Communication Port: COM2 
Baud Rate: 9600 
Communication Type: RS-232 

Refer to point map tables for more detail. 

DNP DCA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: COM3 
Baud Rate: 9600 
Communication Type: RS-232 

The DNP DCA is configured to poll an iBox. If 
you connect COM3 to COM1, you can see the 
DNP DCA polling the DNP DPA. 

WESMAINT 
User Name: westronic 
Password: rd 
Control Password: control 

 

 

 

                                                      
1 Name of the device within the SGConfig sample project 
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iBox Kit with AC Analogs (IBOX-ACA) 
 Configuration Details Comments 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Baud Rate: 9600 
Communication Port: COM1 
Communication Type: RS-232 

Refer to point map tables for more detail. 

Modbus DPA 

Modbus Address: 1 
Communication Port: COM2 
Baud Rate: 9600 
Communication Type: RS-232 

Refer to point map tables for more detail. 

WESMAINT 
User Name: westronic 
Password: rd 
Control Password: control 

 

Note: COM3 is used to connect the AC analog input module to the iBox. 

 

IBOX Kit with DC Analogs (IBOX-DCA) 
 Configuration Details Comments 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Baud Rate: 9600 
Communication Port: COM1 
Communication Type: RS-232 

Refer to point map tables for more detail. 

Modbus DPA 

Modbus Address: 1 
Communication Port: COM2 
Baud Rate: 9600 
Communication Type: RS-232 

Refer to point map tables for more detail. 

WESMAINT 
User Name: westronic 
Password: rd 
Control Password: control 

 

Note: COM3 is used to connect the DC analog input module to the iBox 
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IBOX Kit Ethernet (IBOX-LAN) 
 Configuration Details Comments 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: COM1 
Baud Rate: 9600 
Communication Type: RS-232 

Refer to point map tables for more detail. 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: Ethernet 
Master IP Address: 192.168.1.200 
Slave IP Address: 192.168.1.20 
Subnet Mask: 255.255.255.0 

Refer to point map tables for more detail. 

DNP DCA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: COM3 
Baud Rate: 9600 
Communication Type: RS-232 

The DNP DCA is configured to poll an iBox. If 
you connect COM3 to COM1, you can see 
the DNP DCA polling the DNP DPA. 

WESMAINT 
User Name: westronic 
Password: rd 
Control Password: control 

 

Note: COM2 is used to connect to the Ethernet Module via PPP/TCP/IP. 

 

IBOX Kit with AC Analogs and Ethernet (IBOX-ACL) 
 Configuration Details Comments 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: COM1 
Baud Rate: 9600 
Communication Type: RS-232 

Refer to point map tables for more detail. 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: Ethernet 
Master IP Address: 192.168.1.200 
Slave IP Address: 192.168.1.20 
Subnet Mask: 255.255.255.0 

Refer to point map tables for more detail. 

WESMAINT 
User Name: westronic 
Password: rd 
Control Password: control 

 

Note: COM2 is used to connect to the Ethernet Module via PPP/TCP/IP. 
Note: COM3 is used to connect the AC Module to the iBox. 
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IBOX Kit with DC Analogs and Ethernet (IBOX-DCL) 
 Configuration Details Comments 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: COM1 
Baud Rate: 9600 
Communication Type: RS-232 

Refer to point map tables for more detail. 

DNP DPA 

iBox DNP 3.0 Master Address: 10 
iBox DNP 3.0 Slave Address: 1 
Communication Port: Ethernet 
Master IP Address: 192.168.1.200 
Slave IP Address: 192.168.1.20 
Subnet Mask: 255.255.255.0 

Refer to point map tables for more detail. 

WESMAINT 
User Name: westronic 
Password: rd 
Control Password: control 

 

 Note: COM2 is used to connect to the Ethernet Module via PPP/TCP/IP. 
Note: COM3 is used to connect the DC analog input module to the iBox. 

 
 

DC Analog Input Ranges 
For all bipolar inputs, regardless of whether the input is bipolar current or voltage, 
the following is always true: 

Input Value Value Returned to Master 

Maximum negative input -32768 
Zero input 0 
Maximum positive input 32767 

However, for the 4-20 mA input, the following values are returned by the iBox to the 
master: 

Input Value Value Returned to Master 

Any input in the range of 0 to 4 mA -32768 
Half of Full Scale (12 mA) 0 
Maximum input (20 mA) 32767 
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Appendix C: Resetting the Digi One 
Configuration 

You can restore your Digi One configuration to the factory default configuration, as follows: 

Procedure: 
Resetting the 
Digi One 
Configuration 

Step Action 

1 Turn off power to the Digi One. 

2 With a pointed object, such as small screwdriver or the point of a 
paperclip, press and hold the recessed RESET switch, located on the 
same side of the Digi One as the Ethernet connector: 

 

3 While holding down the RESET button, restore power to the Digi One. 

Result: The Digi One DIAG LED displays a 1–5–1 pattern after about 
20 seconds. 

4 When the 1–5–1 LED pattern is complete, release the RESET button. 

Result: The Digi One boots up and its configuration resets to default. 
The user name resets to root and the password to dbps. 

5 Reconfigure the unit by following the procedure outlined in 
“Configuring the Ethernet Module” on page 109. 

 

 

RESET Switch 
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Appendix D: Setting your PC IP Address 

Procedure: 
Setting an IP 
Address in 
Windows 
2000 

Step Action 

1  In the Windows 2000 Start menu, click Settings. 

2  Click Network and Dial-up Connections. 

3  Double-click Local Area Connections. 

4  Click Properties. 

5  Select Internet Protocol (TCP/IP). 

6  Click Properties. 

7  Select Use the following IP address,  

8  Enter an IP address that is in the same subnet as the iBox, but not used by 
any other devices. Enter the same subnet mask as the iBox. 

9  Click OK. 

10  Click OK in the Local Area Connections window. 

11  Close Local Area Connection Status. 

12  Close Network and Dial-up Connections. 
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Appendix E: DPA Default Point Mapping 

For point mapping of individual standard iBox kits, please look in the Source column of the table below. Point mapping 
corresponding to Plant I/O applies to all types of standard iBox kits. 

DCA DPA 

Source Data 
Type 

MODBUS DCA 
Register 
Address 

Point Description 

COM1 COM2 

DNP DPA 
Point 

MODBUS DPA 
Point Address 

DNP TCP/IP 
DPA Point 

Pl
an

t I
/O

 

DI 

N/A iBox Digital Input #1 0 1 0 

N/A iBox Digital Input #2 1 2 1 

N/A iBox Digital Input #3 2 3 2 

N/A iBox Digital Input #4 3 4 3 

N/A iBox Digital Input #5 4 5 4 

N/A iBox Digital Input #6 5 6 5 

N/A iBox Digital Input #7 6 7 6 

N/A iBox Digital Input #8 7 8 7 

DO 

N/A iBox Digital Output #1 0 9 0 

N/A iBox Digital Output #2 1 10 1 

N/A iBox Digital Output #3 2 11 2 

N/A iBox Digital Output #4 3 12 3 

D
N

P 
D

C
A

 
(IB

O
X-

B
SC

 a
nd

 IB
O

X-
LA

N
) 

DI 

N/A Digital Input #1 on DNP DCA 8 13 8 

N/A Digital Input #2 on DNP DCA 9 14 9 

N/A Digital Input #3 on DNP DCA 10 15 10 

N/A Digital Input #4 on DNP DCA 11 16 11 

N/A Digital Input #5 on DNP DCA 12 17 12 

N/A Digital Input #6 on DNP DCA 13 18 13 

N/A Digital Input #7 on DNP DCA 14 19 14 

N/A Digital Input #8 on DNP DCA 15 20 15 

DO 

N/A Digital Output #1 on DNP DCA 4 21 4 

N/A Digital Output #2 on DNP DCA 5 22 5 

N/A Digital Output #3 on DNP DCA 6 23 6 

N/A Digital Output #4 on DNP DCA 7 24 7 
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DCA DPA 

Source Data 
Type 

MODBUS DCA 
Register 
Address 

Point Description 

COM1 COM2 

DNP DPA 
Point 

MODBUS DPA 
Point Address 

DNP TCP/IP 
DPA Point 

M
O

D
B

U
S 

D
C

A
 

(IB
O

X-
D

C
A

 a
nd

 IB
O

X-
D

C
L)

 

AI 

0 ADAM-4017 AI CH: 00 N/A N/A N/A 

1 ADAM-4017 AI CH: 01 N/A N/A N/A 

2 ADAM-4017 AI CH: 02 N/A N/A N/A 

3 ADAM-4017 AI CH: 03 N/A N/A N/A 

4 ADAM-4017 AI CH: 04 N/A N/A N/A 

5 ADAM-4017 AI CH: 05 N/A N/A N/A 

6 ADAM-4017 AI CH: 06 N/A N/A N/A 

7 ADAM-4017 AI CH: 07 N/A N/A N/A 

C
al

cu
la

to
r D

TA
 

AI 

N/A Scaled Analog Input #1 0 1 0 

N/A Scaled Analog Input #2 1 2 1 

N/A Scaled Analog Input #3 2 3 2 

N/A Scaled Analog Input #4 3 4 3 

N/A Scaled Analog Input #5 4 5 4 

N/A Scaled Analog Input #6 5 6 5 

N/A Scaled Analog Input #7 6 7 6 

N/A Scaled Analog Input #8 7 8 7 

M
O

D
B

U
S 

D
C

A
 

(IB
O

X-
A

C
A

 a
nd

 IB
O

X-
A

C
L)

 

AI 

278 VOLT PHASE A-N INST 0 1 0 

279 VOLT PHASE B-N INST 1 2 1 

280 VOLT PHASE C-N INST 2 3 2 

281 VOLT PHASE A-B INST 3 4 3 

282 VOLT PHASE B-C INST 4 5 4 

283 VOLT PHASE C-A INST 5 6 5 

284 AMP PHASE A INST 6 7 6 

285 AMP PHASE B INST 7 8 7 

286 AMP PHASE C INST 8 9 8 

287 AMP NEUTRAL INST 9 10 9 

288 WATT INST 10 11 10 

289 VAR INST 11 12 11 

290 VA INST 12 13 12 

291 PF INST 13 14 13 

292 FREQ INST 14 15 14 

293 WATT PHASE A INST 15 16 15 
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DCA DPA 

Source Data 
Type 

MODBUS DCA 
Register 
Address 

Point Description 

COM1 COM2 

DNP DPA 
Point 

MODBUS DPA 
Point Address 

DNP TCP/IP 
DPA Point 

M
O

D
B

U
S 

D
C

A
 

(IB
O

X-
A

C
A

 a
nd

 IB
O

X-
A

C
L)

 c
on

tin
ue

d 

AI 

294 WATT PHASE B INST 16 17 16 

295 WATT PHASE C INST 17 18 17 

296 VAR PHASE A INST 18 19 18 

297 VAR PHASE B INST 19 20 19 

298 VAR PHASE C INST 20 21 20 

299 VA PHASE A INST 21 22 21 

300 VA PHASE B INST 22 23 22 

301 VA PHASE C INST 23 24 23 

302 PF PHASE A INST 24 25 24 

303 PF PHASE B INST 25 26 25 

304 PF PHASE C INST 26 27 26 

317 VOLT PHASE A-N AVG 27 28 27 

318 VOLT PHASE B-N AVG 28 29 28 

319 VOLT PHASE C-N AVG 29 30 29 

320 VOLT PHASE A-B AVG 30 31 30 

321 VOLT PHASE B-C AVG 31 32 31 

322 VOLT PHASE C-A AVG 32 33 32 

323 AMP PHASE A AVG 33 34 33 

324 AMP PHASE B AVG 34 35 34 

325 AMP PHASE C AVG 35 36 35 

326 AMP NEUTRAL AVG 36 37 36 

327 WATT AVG 37 38 37 

328 VAR AVG 38 39 38 

329 VA AVG 39 40 39 

330 PF AVG 40 41 40 

331 FREQ AVG 41 42 41 

332 WATT PHASE A AVG 42 43 42 

333 WATT PHASE B AVG 43 44 43 

334 WATT PHASE C AVG 44 45 44 

335 VAR PHASE A AVG 45 46 45 

336 VAR PHASE B AVG 46 47 46 

337 VAR PHASE C AVG 47 48 47 
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DCA DPA 

Source Data 
Type 

MODBUS DCA 
Register Address Point Description 

COM1 COM2 

DNP DPA 
Point 

MODBUS DPA 
Point Address 

DNP TCP/IP 
DPA Point 

M
O

D
B

U
S 

D
C

A
 

(IB
O

X-
A

C
A

 a
nd

 IB
O

X-
A

C
L)

 c
on

tin
ue

d 

AI 

338 VA PHASE A AVG 48 49 48 

339 VA PHASE B AVG 49 50 49 

340 VA PHASE C AVG 50 51 50 

341 PF PHASE A AVG 51 52 51 

342 PF PHASE B AVG 52 53 52 

343 PF PHASE C AVG 53 54 53 

356 VOLT PHASE A-N MAX 54 55 54 

357 VOLT PHASE B-N MAX 55 56 55 

358 VOLT PHASE C-N MAX 56 57 56 

359 VOLT PHASE A-B MAX 57 58 57 

360 VOLT PHASE B-C MAX 58 59 58 

361 VOLT PHASE C-A MAX 59 60 59 

362 AMP PHASE A MAX 60 61 60 

363 AMP PHASE B MAX 61 62 61 

364 AMP PHASE C MAX 62 63 62 

365 AMP NEUTRAL MAX 63 64 63 

366 WATT MAX 64 65 64 

367 VAR MAX 65 66 65 

368 VA MAX 66 67 66 

369 PF MAX 67 68 67 

370 FREQ MAX 68 69 68 

395 VOLT PHASE A-N MIN 69 70 69 

396 VOLT PHASE B-N MIN 70 71 70 

397 VOLT PHASE C-N MIN 71 72 71 

398 VOLT PHASE A-B MIN 72 73 72 

399 VOLT PHASE B-C MIN 73 74 73 

400 VOLT PHASE C-A MIN 74 75 74 

401 AMP PHASE A MIN 75 76 75 

402 AMP PHASE B MIN 76 77 76 

403 AMP PHASE C MIN 77 78 77 

404 AMP NEUTRAL MIN 78 79 78 

405 WATT MIN 79 80 79 
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DCA DPA 

Source Data 
Type 

MODBUS DCA 
Register 
Address 

Point Description 

COM1 COM2 

DNP DPA 
Point 

MODBUS DPA 
Point Address 

DNP TCP/IP 
DPA Point 

M
O

D
B

U
S 

D
C

A
 

(IB
O

X-
A

C
A

 a
nd

 IB
O

X-
A

C
L)

 c
on

tin
ue

d 

AI 

406 VAR MIN 80 81 80 

407 VA MIN 81 82 81 

408 PF MIN 82 83 82 

409 FREQ MIN 83 84 83 

1282 RESET VOLT/AMP/POWER 84 85 84 

1284 RESET MAX/MIN/WH 85 86 85 

AO 
1282 RESET VOLT/AMP/POWER 0 89 0 

1284 RESET MAX/MIN/WH 1 90 1 

CT 

434 WATT HOUR BCD COUNTER 8 N/A N/A N/A 

435 WATT HOUR BCD COUNTER 7 N/A N/A N/A 

436 WATT HOUR BCD COUNTER 6 N/A N/A N/A 

437 WATT HOUR BCD COUNTER 5 N/A N/A N/A 

438 WATT HOUR BCD COUNTER 4 N/A N/A N/A 

439 WATT HOUR BCD COUNTER 3 N/A N/A N/A 

440 WATT HOUR BCD COUNTER 2 N/A N/A N/A 

441 WATT HOUR BCD COUNTER 1 N/A N/A N/A 

Lo
gi

cL
in

x 

CT 

N/A KWH counter 32bit 0 N/A 0 

N/A KWH counter 16bit MSB N/A 87 N/A 

N/A KWH counter 16bit LSB N/A 88 N/A 

 

Notes: 

• ADAM-4017 AI CH: 00 to 07 are converted by the Calculator DTA into two's compliment numbers 
which are stored in the system point database (Scaled Analog Input #1 to 8). 

• WATT HOUR BCD COUNTER 1 to 8 of the AC meter are ASCII BCD numbers. These numbers are 
converted into KW HOUR (KWH counter 32bit) by LogicLinx to be passed to the DNP master. Then 
"KWH counter 32bit" is converted into two 16-bit counters (KWH counter 16bit MSB and KWH 
counter 16bit LSB) to be passed to the MODBUS master.  
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Appendix F: Installing and Connecting 
DNP3 I/O Modules 

This Appendix describes how to install and connect DNP3 I/O modules, and connect to the iBox. 

For more details on the DNP3 I/O module, refer to the 994-0085 Installation and Maintenance Guide. 
 

Overall Procedure to Install and Connect DNP3 I/O Modules 
To install and connect DNP3 I/O modules: 
 
1. Configure the DNP3 DCA in the iBox so that it communicates with your DNP3 I/O module. 

Refer to section: Configuring the iBox to work with a DNP3 I/O Module on page 43. 
2. Physically locate and mount DNP3 I/O module in a 19 inch rack or cabinet. 

Refer to section: Installing DNP3 I/O Modules in a Rack on page 164. 
3. Connect the DNP3 I/O module to site ground. 

Refer to section: Connecting to Protective Ground on page 165. 
4 Interconnect the DNP3 I/O modules and connect power: 

–  For low voltage DNP3 I/O, refer to section: Connecting DNP3 I/O Modules (Low Voltage) on 
page 166. 

–  For high voltage DNP3 I/O where connection is made to an external power supply, refer to 
section: Connecting DNP3 I/O modules (High Voltage) on page 167. 

5 Turn power on to the module, and test it to make sure it is functioning properly. 
It is recommended that you complete the above procedure before connecting and testing your field 
wiring. 
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Installing DNP3 I/O Modules in a Rack 
Rack Spacing 

When mounting multiple DNP3 I/O modules in a rack, or when mounting DNP3 I/O modules in a rack 
with other equipment , verify that there is at least one rack unit (RU) of space above and below the 
DNP03 I/O module to allow for cooling air flow and cable routing (1 RU = 1.75 inches or 44.5 mm). 

Required Clearances 

The exterior dimensions of the DNP3 I/O module are: 

Dimension Measurement 
Width 19 inches (483 mm) 
Height 5.25 inches (133.4 mm) 
Depth 2.5 inches (63.5 mm) 

Allow about 14 inches (356 mm) of total cabinet depth, to provide clearance for cables and maintenance 
access. 

Rack Mounting Procedure 
To mount the DNP3 I/O module in a rack: 
1. Determine the location of the DNP3 I/O module in a 19-inch mounting rack. 
2. Install, but do not tighten the top two mounting screws. 
 Note    Install the DNP3 I/O module with the LEDs visible from the front of the rack. 
3.     Slide the DNP3 I/O module over the top mounting screws and drop down into position. 
4. Insert the bottom mounting screws. 
5. Tighten all four mounting screws. 

You are now ready to connect ground to the DNP I/O module. See “Connecting to protective ground” on 
page 165. 
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Connecting to Protective Ground 

Connect your DNP3 I/O module to site ground, using a separate 2.05 mm (12 AWG) Yellow/ Green wire. 

 
Each type of DNP I/O Module has a different ground point, as shown in the 
examples below. 

The location of the protective ground terminal varies between WESTERM I/O module types. Refer to 
Module Layout drawing of your module for detailed information. For example, see below. 

DC Analog Input Module 

12 AWG
GND Wire

Site
Ground

100

47

97

48 49 50

98 99
TB1

 

Digital Input Module 

12 AWG
GRN GND

Site
Ground

132

63

129

64 65 66

130 131
TB1

 

Control Output Module 

12 AWG
GRN GND

Site
Ground

106

50

103

51 52 53

104 105
TB1

 

Combination Input 
Output Module 

Site
Ground

100

47

97

48 49 50

98 99
TB1

12 AWG
Green Wire

 

After site ground has been connected, you are now ready to connect power, and DNP3 link cabling to the 
DNP3 I/O module. See section: Connecting DNP3 I/O Modules (Low Voltage) on page 166 or section: 
Connecting DNP3 I/O modules (High Voltage) on page 167.  
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Connecting DNP3 I/O Modules (Low Voltage) 
For a Low Voltage (LV) DNP3 I/O module, connect the: 

• Interconnect cabling between each DNP3 I/O module, and 
• Power to the last DNP3 I/O module of the chain. 

DNP3 I/O Module (LV) Interconnect Cabling 

The DNP3 I/O module interconnect cabling is shown below: 

First DNP I/O
Module

Second DNP I/O
Module

J1

To Field Equipment

To Field Equipment

J1

J2

J2

Daisy- chained
to other DNP I/O

Modules

Last DNP I/O
Module

To Field Equipment

J1
J2

Pin

1
4
5
6
7

Other

Function

GND
+DC1
-DC1
TX/RX2
TX/RX2

Not Used

To RTU Master

To Power Source

Cable: iBox (RTU Master)
GE Part Number: 977-0502

To iBox (RTU Master)

To Field Equipment

To Field Equipment

To Field Equipment

To Power Source

J1
J2

J1
J2

J1
J2

Cable: Power Source
GE Part Number: 997-0500

Standard Cables DB9 
male to DB9 male

GE part number: 977-0089

 
After DNP3 I/O modules have been interconnected, you are now ready to connect power to the DNP3 I/O 
modules. See the following subsection: DNP3 I/O module (LV) connection to the Power Source. 

DNP3 I/O Module (LV) Connection to the Power Source 

Connect the power supply to the last DNP3 I/O module in the chain. 

The cable from J2 on the last DNP3 I/O module to the power source (GE part number 977-0500) provides 
the connections shown in the following wiring diagram. 
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1 
2 
3 

4 
5 

6 
7 

9 
8 

Not Connected 

+  DC 
- DC 

+  V 
- V 

Not Connected 

Power Supply DB 9  Male 

 
Connecting DNP3 I/O modules (High Voltage) 

For a High-Voltage (HV) DNP3 I/O Module, for example: WESTERM D20SZ (517-0249-ML): 

1. Interconnect the DNP3 link cabling between each DNP3 I/O module. 

2. Connect pins 1 and 2 (and also pins 3 and 4 if a redundant power supply is used) on 
TB2 to an External Power Supply (40 to 150 VDC) as shown below: 

To iBox (RTU Master)

To Field Equipment

To Field Equipment

To Field Equipment

To Ext Power

To Ext Power

To Ext Power

To Ext PowerCable: iBox (RTU Master)
GE Part Number: 977-0502

External DNP 3 
I/O Module 
Power Supply

 
Note:  The location of the External (Ext) Power Supply terminal varies between WESTERM I/O module 

types. 
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Connecting to a iBox 

The cable from an iBox RTU Master to the first DNP I/O Module (GE Part Number 977-0502) has the 
following connections and jumpers: 

 
Note:  Make sure the iBox RTU Master is configured for RS-485, 2W mode. 
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Appendix G: Error Messages 

When processing an output request, the Plant I/O Subsystem (P097) DCA may not be able to execute the 
request. If this occurs, the Plant I/O Subsystem DCA will set the status code returned with the request to 
the appropriate error code, and negatively acknowledge (NACK) the control request. This section 
describes the possible status codes returned. 

Control Requests Error Codes 
Error Message Description 

Unsupported Point (0x0010) Requested control point is not supported. 

Unsupported Operation (0x0011) Requested control operation is not supported for this point. 

Output Not Available (0x0012) The control output is not available for this point. 

Queue Not Available (0x0013) The control output queue is not available. 

Invalid Request Parameters 
(0x0014) 

The control output request parameters are not valid for this control 
point. 

Too Much Lead Time (0x0015) The control output request lead time is too much. 

Not Enough Lag Time (0x0016) The control output request lag time is not enough. 

Window Too Small (0x0017) Control output request time window is too small. 

No Room on Queue (0x0018) The control output request queue is full. 

Not Armed (0x0019) The control request point is not armed. 

Analog Requests Error Codes 
Error Message Description 

Analog Output Unsupported Point (0x0010) The analog output point is not supported. 

Analog Output Not Available (0x0011) The analog output is not available. 

Online Configuration in Progress (0x0012) Another online configuration change is in progress. 

Online Configuration Invalid Type (0x0013) Configured alarm settings do not match the alarm 
type. 

Online Configuration Invalid Settings (0x0014) Configured alarm settings are out of range. 

Online Configuration Alarm Not Available (0x0015) Specified alarm number is unavailable. 

Online Configuration Invalid Alarm Number 
(0x0016) 

Specified alarm number is out of range. 

Online Configuration No Alarm Number (0x0017) No alarm number has been submitted. 

Online Configuration Cancelled (0x0018) Configuration change is cancelled. 

Online Configuration Time Out (0x0019) Configuration change cancelled due to timeout. 

Online Configuration Disabled (0x001A) Online configuration services are disabled. 

Online Configuration Change Disabled (0x001B) Online configuration change service is disabled 

Online Configuration Out of Events (0x001C) Request rejected. Lacked WIN event buffers. 
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Online Configuration Wev List Not Available 
(0x001D) 

The WEV (WIN event) list request is not available.  

Online Configuration Out of Timers (0x001E) Lacked timed event buffers 

Online Configuration Sendx Fail (0x001F) Message send failed 
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MODIFICATION RECORD 

Version Revision Date Change Description 
4.00 1 March 23, 2005 Document updated for iBox Kit. 

2 August 18, 2005 Updated to reflect new calculator procedures 
5.00 1 October 21, 2005 Updated for ConfigPro 6 and AC Analog Input Module 

2 February 8, 2006 Added info regarding CE Mark, protective earth terminal, and power 
supplies. 

3 April 10, 2006 Updated info about power supply & protective enclosure. 
4 October 5, 2006 Created Appendix G: Error Messages (Control and Analog requests 

error codes). Added info regarding Trip/Close operation in Digital Output 
Verification Test. 
Refer to Clarify Case#  20060727-0259 

October 11, 2006 Clarify Case: 20060605-0257-1: Updated document to clarify on DO 
wiring (Digital Output section in 2.5 Connecting and Testing Field 
Wiring). 

5 January 21, 2009 Minor updates throughout to reflect product enhancements. 
6 March 25, 2009 Documented Ethernet module pass-through switch and configuration file 

modifications. 
5.10 0 February 10, 

2010 
Updated appendices B and E.  

1 June 6, 2014 Corrected ground connections in the drawings of the Digital Outputs 
section.  Corrected the ground reference (chassis ground) in the first 
Caution in the Terminal Connections section. 
Add section: Removing Configuration Data and Sensitive Information 
from the iBox. 

2 July 30, 2014 Added Appendix F: Installing and Connecting DNP3 I/O Modules 
3 Sep 11, 2014 Fixed links. 
4 May 15, 2017 Replaced references to ConfigPro with SGConfig. 

Updated GE branding and contact information. 
Added information on battery “PULL” tab removal during iBox 
installation. 
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